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Preface

In front of you lies the research report on the development of a method to map
gully erosion. This research report has been written as a product for my bachelor
internship and as a manual for colleagues who wish for an accessible method to
map and quantify gully erosion at NIBIO in As, Norway. I have worked on this
project since March the 25% 2019 until July the 5% 2019.

At the beginning of my internship, I only had a slight idea on what I was getting
myself into. I knew that a method had to be developed to measure gully erosion
with drones and roughly which software could be used for it. It was the first time
for me to be abroad for a longer period, so I was a bit nervous in the beginning
and needed more aid and help from my colleagues to get the hang of all the
work that needed to be done.

Thanks to Robert Barneveld and Jannes Stolte I managed to apply the software
necessary to get a model of gullies. I learned a lot about how to apply Photoscan
to create height models. I also learned how to successfully apply SAGA to create
profiles and how to use Excel for further calculations on gully erosion. The
successful application of LISEM is also a skill I picked up while I was here at
NIBIO. To model catchments, and thus gully erosion in Skuterud.

I would like to thank Jannes Stolte and Robert Barneveld for their aid, patience
and their expertise that helped contribute to this product!

I would also like to thank Rémon Saaltink, my family and friends for his
enthusiastic support and feedback during this internship abroad.

All your aid and help during this internship has encouraged me greatly to deliver
this research report and manual to you.

May it aid you well.
Maurice Pals,

As, 3th of June 2019.



Summary

Project MetFure is a project within NIBIO that is striving to develop a method to
measure, map an quantify gully erosion, utilising drone photogrammetry. The
reason behind this project is that the need existed for a faster method to map
gully and quantify gully erosion. Drone-photogrammetry offered a solution to this
problem.

Still, there was no set method to map and quantify gully erosion using drone
photogrammetry to this day. So, the goal was to develop a set method, using
drone photogrammetry and new software to map and quantify gully erosion.

To come up with a set method, multiple approaches and tests have been carried
out to effectively use the software. These tests include, comparing conventional
measurements to drone measurements and a lot of working with software like
Photoscan, SAGA and LISEM. The working and testing with this software have led
to a manual that describes the method to map and quantify gully erosion from
beginning to end.

The end results are the manual with the method for quantifying and mapping
gully erosion along with a couple of recommendations on how to measure and
map these processes. These are, to keep an eye out for grass tufts when
measuring gullies with drones. The drone cannot distinct grass from soil
accurately, so this is something to keep in mind. The deviation between the
conventional measurements and drone measurements on average is about 1
centimetre, which is caused by vegetation.

For this reason, it is safe to assume that, when measuring larger gullies with the
drone, this deviation will not occur if these larger gullies are “fresh” and contain
no vegetation when measuring with the drone. The deviation of 1 centimetre also
proves to be less of a problem when measuring bigger gullies. For example,
when measuring a rill with a depth of 5 centimetre, then a deviation of 1
centimetre makes much more of a difference in the calculation of the rills volume
than it does when calculating the volume of a big gully with a depth of 30
centimetres. This proves that measuring bigger gullies with drone
photogrammetry provides enough accuracy to get a good idea of the amount of
gully erosion that takes place.

Another recommendation is that, when measuring gullies with drones, to set the
altitude of the drone according to the slope of the area. The best altitude is 20
meters because this offers the best quality image in relation to the least amount
of processing time in the software. When taking off with the drone at the foot of
a slope, it is recommended to set the drone height a bit higher to ensure enough
overlap of the images is achieved at the higher points of the hill. This is because
the drone remains at a stationary altitude once it has taken off.
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1 Introduction

NIBIO is doing research on gully erosion and is developing a way to effectively
map and quantify this, using drones and software. The study was commissioned
by the ministry of agriculture of Norway. The project started on the first of
January 2018 and will end on the first of March 2021. This is an important study
because gully erosion is a threat to soils and surface waters in Norway. For
example, eutrophication of the surface waters occurs when a gully is connected
to surface waters. This is a big problem because it affects ecosystems in the
surface waters. Eutrophication occurs when there is an abundance of phosphates
in the surface waters. Farmers use fertilizers, containing phosphates, on their
land and these fertilizers end up in surface waters via catchments (gully erosion).
The abundance of fertilizers in the water causes a rapid growth of algae, which
will then proceed to cover the water surface. This causes the sunlight to be
blocked, which water plants need to survive. The oxygen in the water drops since
the water plants that produce it will die due to a lack of sunlight. This causes a
lack of oxygen in the water which will then proceed to wipe out the rest of the
aquatic life in the area. Mapping and monitoring the gully erosion that carries
phosphates to the surface water is therefore essential to prevent the
eutrophication of the surface waters.

There is still is not an easy method for mapping and quantifying rill- and gully
erosion. For this reason, there is the need for more knowledge on rill- and gully
erosion and which new technologies can be of use to model it. The coming weeks
will mainly compose of experiments with drones and the use of applicable
software to quantify gully erosion. Some calculations will also be made utilising
LISEM, to quantify soil- and gully erosion.

The goal of this study is gaining more knowledge on quantifying rill- and gully
erosion and developing a method to map and quantify it effectively. The areas in
which the study will take place are Skuterud and Mgrdre. These areas are
representative of other agricultural areas in Norway and contain some rills to
measure with drones.

The developed method for mapping and quantifying gully erosion shall be
recorded in @ manual. Also, the way the method has been developed will be
recorded. This manual will offer employees within NIBIO an anchor to map gully
and rill erosion more effectively.

This study will contribute to a better understanding of the way gully erosion
should be quantified. This contributes the rest of society with a means to easily
monitor gully erosion, utilising drones and software. Within the first 4 weeks of
the study period, an attempt will be made to scan the entire area of Skuterud
and Mgrdre. This must be done within 4 weeks because the farmers will start
ploughing the area after that period. After the land has been ploughed, the rill
and gully erosion will not be measurable anymore.

of applied sciences



2 Research questions
To give this research more direction, a couple of research questions have been
set up. The research questions can also be used as a reading guide.

Main question:

What kind of method should be used to increase the effectivity of quantifying the
furrow erosion with drones?

Sub-questions:

1. What is the best altitude for drones to map soil erosion with a good quality
and in as little time possible? (paragraph 3.1 and 3.2)
2. Where are the gullies in Skuterud? (paragraph 4.3)
3. How does one calculate the volume of the gully’s that where mapped with
the drones? (paragraph 4.1 and attachment II)
a. How does one calculate the volume of the gullies? (paragraph II.5
and 4.1)
b. Which software is needed for which steps? (paragraph II.1 till
paragraph II.4 and 4.1)
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3 Approach

In this chapter, the development of the method for quantifying gully erosion is
substantiated. It is also explained how the best methods we’re chosen. The
method has been developed while mapping ephemeral gully erosion. For more
about ephemeral gully erosion, see attachment I, paragraph I1.3.

3.1 Determining the optimal flight method for drones

The eventual flying method for mapping gully erosion is decided within the first
two weeks of the internship. Nine test flights have been carried out on the
campus of NMBU. An overview of the test flights is given in Table 1.

Table 1 Overview of test flights (DJI GO, is the original app to plan flights with for drones of the

DJI-brand.)

Planned flight with Manual flight with DJI ~ Manual flight with
Precision Flight with GO-app with only the  PrecisionFlight with
scan of entire area. important area only the important
(speed = 10 m/s) (variable speed) area (variable speed)
(pictures after every (recording) (recording)
few meters)

altitude | 10 meters 10 meters 10 meters
15 meters 15 meters 15 meters
20 meters 20 meters 20 meters

With each test flight, the drone is told to map a certain stone in the area. The
test flight that has the most detailed image of that certain stone will be the
method that is going to be used to map gully erosion. The stone is about 10
centimetres high. The aim is a clear picture of about two to three pixels per cm?
to use the method for mapping gully erosion.

After performing the 3 flight methods on three different altitudes. The pictures
and movies were converted into a model of the area, using Photoscan. It
immediately became clear that the areas mapped, while filming with a camera,
were way less accurate then when using pictures. The 3D models of the films are
bend and not reliable to use for further use. That leaves the planned flights with
PrecisionFlight as the only reliable option.

In addition, three models were made of the area with three different altitudes in
Photoscan. The altitude of 20 meters provided a clear image of the area with a
resolution of 0,8 mm per pixel. This is deemed enough to calculate the gully
volume in the next steps. More over this test in paragraph 3.2.1.

3.2 Determining the method for quantifying gully erosion using
software.

In this paragraph it is described how the methods for the manual are developed.
This chapter focusses mostly on the effective utilisation of software.

3.2.1. Developing the usage of Photoscan.
The aim of this step is to generate a Digital Elevation Model (DEM) with a
resolution of about 0,8 cm per pixel.
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The best way to utilise Photoscan is determined with multiple tests. Three flights
are made on three different altitudes; 10, 20 and 30 metres. Of these flights,
three different models are made. Of every flight, multiple models were made
with different quality of resolution. The resolution of multiple combinations of
altitude and processing-quality of the dense cloud in Photoscan are given in table
2. Generating the dense cloud is by far the most time-consuming step in
Photoscan. It is important to experiment with different dense cloud qualities, for
it will save a lot of time. Only the ultra-high and high qualities are chosen here
because any lower qualities will not suffice for the quantifying of gully erosion.

Table 2 resolution of every image with different combinations of altitude and dense cloud quality.

altitude 10 metres 20 metres 30 metres
Resolution of X X X
dense cloud
Ultra-High: 3,95 mm/pixel 6,75 mm/pixel 10,3 mm/pixel
High: 7,9 mm/pixel 13,5 mm/pixel 20,7 mm/pixel

Another important factor when generating a model is time. To show a relation
between the amount of time and the quality of the model, an overview is made
of the amount of time that was used to generate the different models (table 3). A
lower altitude while flying means that more pictures of the area are taken. more
photos mean longer processing times in Photoscan.

Table 3 amount of time consumed while generating models in Photoscan

altitude 10 metres (194 20 metres (78 30 metres (37

photos) photos) photos)

Quality of model x X X
Ultra-High: 35,7 hours 14,25 hours 6,3 hours
High: 7 hours 3,6 hours 2,7 hours

Using the processing times from table 3, the average processing times of photos
per hour were calculated and put into table 4.

Table 4 average processing speed in photos per hour

Number of 194 photos 78 photos 37 photos Average
photos processing
processed time
Processing Photos/hour Photos/hour Photos/hour Photos/hour
speed
Ultra-High: 5.4 5.5 5.9 5,6
High: 27.7 21.7 13.7 21,0

The average processing times for the models differ with each quality setting.
When wanting an ultra-high-quality image, the average processing time is
around 5,6 photos/hour in Photoscan. The number of images that need to be
progressed do not affect the average processing time of 5,5 photos/hour.
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However, when generating a model in High quality, the average processing
speed differs per number of photos taken. When generating a large quantity of
photos, the average amount of photos processed per hour rises as well.

Knowing that Photoscan processes around 5,6 photos per hour in ultra-high
quality. One can calculate the processing time beforehand. The relation between
height, scale of the area and with that the number of photos, can be used to
determine a fitting resolution of the model, and with that, save time processing
the model. The formula used here is:

amount of photos
5,6

(ultra high) processing time in hours =

Since the average processing time on high quality differs per number of photos
taken, there is not a definitive way to formulate a formula to calculate the
processing time beforehand. However, the tables do give an insight in the
process. This is enough to make a rough guess of the expected calculation time.

3.2.2 Developing the usage of SAGA

SAGA is a program that allows the modelling of charts and certain 3D aspects of
it. The calculation method of the gully’s volume is developed in SAGA. Robert
Barneveld developed most of the steps to calculate the gully’s volume in SAGA.
These steps are documented in the manual

3.2.3 Developing a method with LISEM

LISEM is software that allows one to simulate catchments of all kinds of areas.
The goal is to simulate the catchments of Skuterud to see where in Skuterud it is
necessary to check for gully erosion. A strong base with all the files needed is
already available for Skuterud. From here, the first simulation was made of the
catchment. The focus in this simulation is around gully erosion.

Still, some files must be adjusted to run a good simulation of the catchment in
Skuterud. These files represent multiple parameters that are recognisable for the
area. These are:

- Crop height (ch.map)

- The leaf area index (lai.map)

- Percentage of vegetation covering the soil. (per.map)

- The soil profile (profile.inp and profile.map)

- Characteristics per soil type, like permeability (The SWATRE tables)

For more info about these files, see the literature study, paragraph 1.14. A
detailed explanation is given of each filetype.

These map files need to be adjusted to match the conditions of when gully
erosion occurs. For gully erosion occurs during the end of winter, start of spring.
This time of year, it is still cold and wet. This means, a less permeable soil
because of the frozen subsoil. A low k-value is required. There is also less
vegetation during this time of year, which causes less interception. How to
change these values is explained in the manual, paragraph I1.6.2.

4
hQ NIBIO
NORSK INSTITUTT FOR

U nlvefS|t BIO@KONOMI

of applied suences



4 Results

The manual for the best method is given in the following paragraphs. In this
chapter, the method for mapping and quantifying gully erosion will be explained
step by step in a compact manner. The manual explains every step in high detail,
this can be found in attachment II.

4.1 The method for mapping and quantifying gully erosion.
In this paragraph the theory and results behind the method are summarized.
From the first steps to last.

4.1.1 flying the drone

To effectively map gully erosion in the field. the drone needs to fly at an altitude
of about 20 metres. This results in the least processing time with the software
and a relatively fast flight. This altitude also does not compromise the resolution
of the image.

4.1.2 making a DEM in Photoscan

The following process must take place in Photoscan. The Photos that were made
with the drone are imported to Photoscan and then the following steps must take
place via the Batch processing feature;

1. Photo alignment (Ultra-high quality)

o Here, the software will try to find overlapping aspects within the

images to align them to get one big image of the area.
2. Dense cloud generation (Ultra-high quality)

o In this step, Photoscan finds lower and higher points that were
measured by the drone and are saved in the images and then
proceeds to make a dense point cloud. This dense cloud is the
skeleton of the Mesh (3D-Model)

3. Mesh building (Ultra-high quality)

o The mesh is a 3D model of the area that is being generated from
the Dense cloud.

4. DEM generation (Ultra-high quality)

o The Digital elevation model (DEM) is the height model that is
needed to calculate the gully’s volume. This DEM is generated using
the Mesh.

5. (optional) orthomosaic generation (Ultra-high quality)

o The orthomosaic can function as a clear image of the area. This can
be useful to clip the rill or gully with a polygon in saga. It is also
possible to spot vegetation and other characteristics of the soil with
this layer, but it is not necessary for the calculation of a gully’s
volume.

6. Export of DEM and orthomosaic in a directory in the “"WGS 84 / UTM zone
32N (EPSG:32632)” coordinate system format

Ultra-high quality of these models allows for the best calculations of the gully’s
volume in SAGA. An example of a DEM is given in figure 1
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Figure 1, A Digital Elevation Model (DEM) of a creek near an agricultural field, Created in
Photoscan.

4.1.3 Calculating a gully’s volume in saga

The calculation for the gully of the volume has been developed in SAGA. in this
paragraph, the calculation is summarized shortly. To get the volume of the gully,
the map layers need to be modified in a couple of steps.

The first step is to cut the area interest out, it is possible to import the
orthomosaic for this task or use analytical hillshading to spot the rill in the DEM.

Then the DEM must be resampled. Resampling basically means setting a new
resolution for the DEM by making the pixels bigger. By increasing the size of the
pixels, the different heights per cell will be flattened according to the average
height of the multiple pixels the new pixel will envelop. The bigger cells will then
be resampled again to their former size, but they will keep the same values in
these cells. Figure 2 depicts this process schematically.

4,314,3/4,3
Resampling

Resampling

4,3 14,3(4,3

4,3

4,31 4,3(4,3

Figure 2, Resampling a 9 Dem cells into 1 DEM-cell (making it bigger) creates a new average value
per cell, flattening the surface, resampling it back to the last resolution will keep the same)

The second Resampled DEM will be subtracted from the original DEM-part with
the gully/rill. This will present us with the gully’s volume.

It is not reliable to straightforwardly subtract the resampled DEM from the
original DEM. For this reason, only the exact location of the gully in the
resampled DEM and original DEM must be subtracted from each other.

has NIBIO
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This must be done in multiple steps because the DEM is a grid layer and the gully
in the DEM needs to be transformed in a shape to cut out the gully in the DEM.
Analytical hillshading can be used to spot the gully in the DEM. After the DEM
and resampled DEM are roughly cut with a polygon around the gully, the next
steps must be taken;

1.

Fill sinks (Planchon/Darboux)

o This function fills sinks and holes in the area that are not a rill or
furrow.

Downslope area function on original DEM.

o This is an algorithm that follows the lowest slope in the area (so a
rill or gully is the logical way to follow). It is an interactive tool, so it
is important that the start of the gully is clicked to get a schematic
line of the gully.

Conversion of grid values to points.

o The layer that the Downslope area function created must be
converted to points. This can be done by selecting points with
values on the data of the downslope area layer. If all data that is O
is considered as no data, then one can easily select the rill/gully and
create points on it.

Conversion of points to lines.

o Once these points are created, the points can be converted into
lines to create a line following the gully.

Creating a buffer around the line until it overlaps with the gully.

o The line that is created will then be used to make a buffer that
overlaps the gully. Be sure the buffer is only as big as the gully
itself to get a more exact answer on the gully’s volume.

The shape of the buffer is then used to cut the rill and gully out of the
original DEM and Resampled DEM.

The grid difference function is then used to subtract the cut versions with
the buffer of the resampled DEM from the original DEM.

The grid difference layer that appears is then used to calculate the volume
with the grid volume function in SAGA.

Now the volume of the rill is calculated. For a deeper explanation on the
trustworthiness of the grids and drone measurements, read the discussion in
chapter 5. For the exact walkthrough to calculate the volume of gullies, see
attachment II.
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4.2 Theory on detrending the cross section of gully profiles to
compare drone measurements and conventional measurements.
To compare conventional measurements with the drone measurements, the gully
needs to be detrended. This method is developed and is one of the results that
this research report contains. Detrending basically is removing the slope in of an
area without removing the details like crevices, gullies or rills. Detrending the
slope will make it easier to calculate a gullies volume for the quantification of
(ephemeral) gully erosion.

If the slope is removed, it is possible to compare the profile of the gully very
accurately. This is done in the with conventional measurements and drone
measurements of gullies in chapter 5.

First some explanation about what kind of geometrical calculation needs to be
performed on the data, that is at hand. Removing a slope without changing the
volume of a gully can be done by considering slope as a triangle. An example is
given in figure 3.

Figure 3, The slope of the profile of a gully.

For a better overview, the same triangle is given one more time but without the
gully in the background with a description of all angles. (figure 4)

— C

A

—— B

Figure 4, Depiction of the slope at a gully.

The first step to detrending is calculating the tangent of Angle A. The formula for
calculating the tangent of a rectangular triangle is:
T . Opposite side
angent = Adjacent side
Side AB is as long as the line that was made in SAGA. Meaning the last nhumber
in the attribute table in the DIST_SURF column. This can be like 80 centimetres
for example.
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Side CB should be the elevation relative to point A. This can be determined using
the Z column from the attribute table. To determine the length of side CB just
subtract the Z value of angle C from the Z value of angle A. In other words:
Subtract the first value from the last value of the Z column in the attribute table.

*A tip*

It is easier to the first value as 0. And start counting from counting the elevation
from there for it will give a better overview of the gully when making a cross
section in the form of a chart. More about this will be explained in the next
paragraph when this calculation will be put into practice in Excel.

Once the Tangent of angle A is calculated, one can then remove the slope to
create a flat area, while the gully maintains the same volume. This requires one
more calculation, using the tangent. This formula is used to create a detrended
point utilising the specific values from the attribute table of that point:

Detrended point = Z — Tangent * DIST_SURF

By using this formula for every point in the attribute table, one can create a
chart that serves as a detrended cross section of the profile. Allowing further
analysing of the gully profiles.

After the detrending the gully profile will look something like figure 5

Figure 5, Detrended gully.

The flat line over the surface allows for a stable value to measure the depth of
the gully at all points. Which will improve the accuracy of the calculation for the
gully’s volume.
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4.3 Checking the gully’s locations with LISEM.

A simulation is made of the area of Skuterud when it comes to gully erosion. The
goal of this simulation was to check whether the predicted catchment locations in
LISEM would appear in the same locations in the field. Figure 6 shows the
simulation made with LISEM.

Total Discharge (l/s)
2,500

F|

100

2,000

1,500

10

1,000

500 o

0.1

T T T T T T T T
-500 0 500 1,000 1,500 2,000 2,500 3,000

Figure 6, Gullies/Rills in Skuterud.

Due to rainfall, the following catchments started to appear according to LISEM.
The catchments that were seen in the field are, encircled in the map. These
catchments were only small rills. This is because due to a lack of rainfall and
snowmelt during the end of last winter, this was measured in the measuring
stations from NIBIO around Skuterud.

It takes some knowledge on how LISEM works to find out how to make
simulation like this one. That is why this is also explained in the manual, in
attachment II, paragraph I1.6
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5 Discussion
In this chapter, the results and method are interpreted, and contradictory results

examined and explained. The discussion mainly focusses on the validity of drone
measurements in comparison to the conventional measurements.

Three conventional measurements of gully-profiles were taken in the field to test
the drone imagery for accuracy. These measures were taken in Skuterud. The
goal here is that the drone measurements will not deviate from the conventional
measurements for more than 1 cm on average to successfully measure rills.

Two kinds profile measurements were made:

1. One using the conventional measurements method with a scale
2. The other profile measuring method was made using drone photogrammetry.

Making a profile from the data the drone collected requires quite a few steps in
SAGA and Excel. Figure 7 shows gully profiles that were measured
conventionally in the field. These portray the rill’s profile.

schematic cross section profile 2
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Figure 7, All conventional profile measurements of a Rill in Skuterud.
For a description on the research design of this experiment, read attachment III.

The drone measurements compared to the conventional measurements are
portrayed in the following charts. The first chart in figure 8 displays profile 2
using the two methods of measurement.
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Profile 2
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Figure 8, Cross section of profile 1.

The drone has captured the Rill’s profile and shape well. The average absolute
value is about 1,1 centimetres. (the average deviation from the conventional
measurements)

The fifth profile measurement is shown in figure 9. The average absolute value of
the drone measurement is about 1,4 centimetres in relation to the conventional
measurements.

profile 5
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Figure 9, Cross section comparison of profile 5.

There is no deviation when it comes to distance over surface. This can be proven
since the start and end of the of the drone measurement and conventional
measurement are at identical locations. The conventional measurements have a
standard deviation of 1,4 centimetres on average. Still this is not accurate
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enough since the goal is a maximum deviation of 1 cm. The peak at the start of
the chart (c. 0.2 m distance), is caused by tufts of grass.

When it comes to figure 10, there is the least amount of deviation between the
conventional and drone measurements.

profile 6

0,02

1,4
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— -0,04 conventional measurements

@ drone measurements
-0,06

-0,08

-0,1
Distance over surface.

Figure 10, Comparison conventional / drone -measurements.

On the sides of the gully there are some slight deviations from each
measurement. This is likely caused by tufts of grass. The standard deviation of
the drone measurements in relation to the conventional measurement is 0,4
centimetres.

In conclusion, the drone measurements differ a couple of centimetres in relation
to the conventional measurements. After examining the areal pictures, it is very
likely that these deviations are caused by tufts of grass. This is something to
keep in mind when measuring rills next time. This can be prevented to start and
end the conventional measurements on (more) bare spots of land. These are
more easily distinguished by the drone.

This rill was very small (only about 10 centimetres deep). When measuring large
gullies (around 30 to 50 centimetres deep) this slight deviation will not cause
much problems when calculating the gully’s volume. This is because the big
gullies do not contain the vegetation that cause the deviations in the drone
measurements. This means it can be presumed that drone photogrammetry is
suitable for measuring big gullies. Another advantage is that drone
photogrammetry is much faster than the conventional method and allows for the
generation of height models unlike with the conventional methods.

The standard deviation of < 1,4 cm is a problem for measuring small rills but the
speed of drone photogrammetry and this slight deviation in relation to the
measuring of bigger gullies does not outweigh the speed of drone measuring in
comparison to any conventional means.
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6 Conclusions

The conclusions of this report are based on a couple of recommendations. These
are things to keep in mind while flying the drone or when calculating the gully’s
volume.

For starters, when flying the drone, it is recommended to look at the slope of an
area before releasing the drone in the air. The drone will only fly on an altitude of
20 metres from its starting point and will not go higher or lower to match the
altitude based on the slope of the area. If the drone needs to fly upwards a slope
on route, it is recommended to set the altitude a bit higher than 20 metres to
ensure enough overlap of the imagery further up the hill.

Another recommendation is that it is important to keep in mind that grass tufts
can compromise the drone’s accuracy when measuring a rill of gully. The drone
will see grass tufts as elevations in the area, while this is not the case. This is
something that was dealt with during the research on the drone’s accuracy when
measuring gully erosion in the field in comparison to conventional
measurements.

Since the deviations between conventional measurements and drone
measurements where around 1 cm each, and were mostly caused by tufts of
vegetation, it is safe to assume that larger gullies are suitable to measure with
drone photogrammetry. This is because large gullies are about 30 cm deep and
contain no vegetation that will cause the drone measuring to deviate. Also, a
deviation of 1 cm would not impact the outcome of the volume calculation of
these gullies as much as with little rills, which proves that drone
photogrammetry is acceptable for the measuring of larger gullies. Especially
because drone photogrammetry is a much faster method than any conventional
means.
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Attachment I: Study of literature

To effectively participate in the MetFure project. There existed a need of more
knowledge about the subject “"Gully erosion” and the modelling-programs that
are used to map the Gully erosion. In this attachment, the research conducted
on these subjects is summarized. There is also information about NIBIO and
what this research institute does.

I.1 About NIBIO

NIBIO is an abbreviation of “"The Norwegian Institute of Bio-economy Research”.
NIBIO researches a wide spectrum of subjects. Their main aim is to contribute to
food security and safety, sustainable resource management, innovation and
value creation through research and knowledge production within food, forestry
and other bio-based industries. (NIBIO, 2019)

NIBIO is divided in a couple of divisions. These divisions are:

- The Division of food Production and Society

- The Division of Biotechnology and Plant Health

- The Division of Environment and Natural Resources
- The Division of Survey and Statistics

- The Division of Forestry and Forest Resources.

The MetFure project takes place within the Division of Environment and Natural
Resources. To tell something more about this division, this division performs
research on the following subjects;

- Soil;

- Water;

- Waste;

- Vegetation;

- Green technology;
- And climate.

The Division of Environment and Natural Resources aims to find, present and
make use of research-based knowledge. The gained knowledge will then be used
to secure a safe environment and to protect and utilise natural resources in the
best possible way.

The Division of environment and Natural Resources contributes to the
development of bio economy in Norway and abroad. Their contribution consists
of the documentation and development of biology based environmental
technology and natural processes. These technologies and systems can then be
used for things like sustainable recycling of waste derived from the industry into
energy resources. Another thing that this division is doing is the realisation of
urban greening. Urban greening is important because it contributes to the
mitigation of extreme weather effect and provides better chances to utilise local
resources.

The Division of Environment and Natural Resources consists of several
departments. These departments are called:

- Bioresources and Recycling Technologies
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- Soil and Land use

- Soil Quality and Climate Change
- Terrestrial Ecology

- Water Resources

- Ecosystems in the Barents region

The MetFure Project takes place within the department of Soil and land use.
(NIBIO, 2019)

The focus of this department is creating a better understanding of the water
pathways and soil processes that lead to nutrient and particle transport. The goal
in mind here, is to contribute to the reduction of environmental effects that
negatively impact the usability of the soil, especially for agricultural purposes.
Examples of these processes are soil erosion and nutrient loss. The Department
of Soil and Land use aims to increase their understanding of these processes so
that measures can be taken to protect agricultural fields etc. (NIBIO, 2019)

I.2 About the MetFure Project

The internship’s focus rests on the MetFure Project. This Project’s main goal is
the development of a method and testing of drone-photogrammetry to quantify
furrow erosion (rill- and gully erosion). (This is Fure-Erosjon in Norwegian,
hence the name of this project). After quantifying the furrow erosion, there will
be an estimation of the contribution of this type of erosion to the total soil loss in
Norway.

The project has a couple of sub-goals:

1. Gaining more knowledge about during which weather conditions, which
climate conditions and where on the farmland furrow erosion occurs.

2. Gaining more insight in the amount of runoff of particles and nutrients that
is caused by furrow erosion to surface water.

3. The developing of a manual for management and the individual farmer to
be able to map out erosion while making use of a regular camera.

The group that is targeted for is project is the agricultural and waterway
administration from local to national level. (NIBIO, 2019)

The MetFure Project is part of the JOVA program. The JOVA program is the
Norwegian Agricultural Environmental Monitoring Programme. (the Norwegian
abbreviation is JOVA). The JOVA programme aims to monitor and document the
environmental effects that are originating from agricultural practices.

The results from JOVA are taken by the government for in their policy with the
farmers. The results from the JOVA programme are also important for the next
measures that should be taken with the implementation of the Water Framework
directive. (WFD, KRW in de Netherlands.) (NIBIO, 2019)
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1.3 Different types of soil erosion

Furrow erosion is caused by furrow irrigation. Furrow irrigation is a type of
irrigation that makes use of furrows within agricultural fields. An example can be
seen in Figure 11. It is one of the oldest methods to irrigate agricultural fields.
Water is being sprayed into the furrows from one side of the field. And the runoff
water is let out on the other side of the field.

Figure 11: A crop field being irrigated with the furrow irrigation method. (Quora, 2018)

These furrows are often the starting point where rill erosion appears, followed by
gully erosion. (read 1.4 for a more detailed explanation) Many definitions are
used for this kind of erosion without a clear distinction between rills and gullies.
(@ygarden, 2001). Here at NIBIO, rills are classified as small furrows that are
about 10 cm deep and do not encounter surface waters. Gullies however, do
encounter surface waters and are deeper than rills. The deepest gullies in
Norway are about 50 cm deep.

One of the most common used definitions (to separate rills from gullies) is that
gullies are deep enough that normal soil tillage will not be able to remove them.
If tilage can remove them, then it is called rill erosion (less than 30 cm deep).
Rill erosion is sometimes called ephemeral gully erosion.

Definitions and distinction vary with every study. Within this study, the definition
of rill erosion will be utilised. Rill erosion is entirely caused by flow and not by the
impact of raindrops. Ephemeral gullies are short-lived since the area is annually
being restored by tillage. Classical gully erosion however, is more permanent.
Ephemeral erosion develops where water naturally concentrates in furrows in
ploughed fields. Other locations where rill erosion may occur are field roads or
thalwegs. (@ygarden, 2001)
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Another type of erosion is sheet erosion. sheet erosion occurs when thin layers of
soil are removed from sloping land. the velocity of surface run-off is about 0,3 to
0,6 meters per second when sheet erosion appears. The direct impact of
raindrops causes the soil to move downhill. (splash erosion). When time
gradually progresses, sheet erosion starts to become detectable and can be
observed. For example, the exposure of subsoil and roots.

I.4 The development of gullies in a nutshell

In Norway, gully erosion is a problem, due to heavy rainfall and the melting
snow. In the beginning of spring, there is a lot of water that needs to run off.
The rills within the agricultural fields cannot carry all the water. The reason for
this is because the top layer of the soil (Topsoil) is very porous due to the
melting of the ice within the soil. However, the layer underneath the top layer
(Subsoil) is still frozen, which prevents further infiltration of water. The water
cannot infiltrate further into the soil, so rills join, and large gullies start to appear
upon the surface. Another factor is that, at the time the snow is melting, there
are no crops in the field, so there is little to no capacity to absorb the waterflow.
The furrows start to erode, and the nutrients and soil start to wash away due to
the large amount of water. Large gullies start to appear because of the erosion
(Figure 12). (@ygarden, 2001)

Figure 12: Gully erosion on an agricultural field at the end of the winter (clay). (Fieldcropnews,
2017)

These gullies cannot be eliminated by any normal means like tilling or ploughing
because they are too deep. These gullies are mostly deeper than 30 cm. (Geyik,
1986)

The waterflow transports the nutrients, particles and phosphates to the lowest
point in the area, which is usually a lake or a river. Here, the extra nutrients, soil
particles and phosphates end up in the surface water. This creates new

problems.
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1.5 Eutrophication

Phosphates are common in the fertilisers that are used in the agriculture. They
increase plant growth. After the harvest, a lot of these phosphates remain in the
soil. When this soil encounters processes like gully erosion, the phosphates are
being transported with the waterflow to surface waters. The problem that occurs
next is eutrophication. Eutrophication is what happens when an excess amount
of organic matter is present within the surface water. (In this case, Phosphates
are the cause for the eutrophication.)

When there are too much Phosphates in the surface water, the number of algae
in the surface water will increase rapidly. The number of algae will be so large
that the entire surface of the water will be covered. No sunlight can get through
the water surface anymore, resulting in the dying of flora underwater. The
rotting flora uses up de oxygen in the water which result in the death of fish.
(University of Wageningen, 2019)

For this reason, it is important to take measures against gully erosion and to
protect the surface waters against it.

I.6 Protecting the soil

Another reason for wanting to take measures against gully-erosion is, wanting to
protect the soil and its ability to grow crops on it. Gully erosion takes nutrients
and usable soil away and the streams render that part of the soil useless.
Especially when there is a lot of water that needs to run off, like during heavy
rainfall and the thawing of snow. Phosphates in the soil are crucial for providing
people with enough food. The amount of Phosphates on this earth is not
limitless. For this reason, there is the need to utilise the phosphate sources in a
sustainable way. Gully erosion is a waste of phosphate that could otherwise be
used for agricultural purposes.
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1.7 Factors that influence the origination of gully erosion
When formulating the measures against gully erosion, one should always know
how the gully erosion originated and which factors contributes to that origination.

The origination of gully erosion depends on a lot of factors:

- The amount of topsoil thawed,
- The permeability of subsoil,
- Whether the pores in the top soil are already saturated with water or not,
- The weather conditions,
o the amount of rainfall,
= monthly distribution of rainfall
* rainfall intensity and run-off
o The amount of snowmelt,
- Topographical factors

o Shape of catchments

o Size of catchment, (A large catchment means a large amount of
run-off.)

o Length and gradient of the slope. (Longer slopes mean more
accumulation of water towards the base), (The steeper the slope the
higher the velocity and erosive power of the run-off)

- The type of sail,

- The amount of vegetation left during the winter season. (more vegetative
cover means more interception of rainfall)

- How often the agricultural field is being ploughed,

- Knickpoints in the slope,

- The changing of land use,

- The gradual changing of the climate,

- Tracks of vehicles and livestock

- (Other) measures that were already taken against gully erosion

(Geyik, 1986) (@ygarden, 2001)

All these factors (and possibly even more) dictate the risk of originating gully
erosion. So, while formulating a strategy to counter gully erosion, one should
consider these factors before implementing measures. Some measures might be
more effective than others when taking the originating factors into account.

1.8 Taking measures against gully erosion

Multiple measures can be taken to reduce the risk of gully erosion. The best
measure depends on the factor that is the most normative for the origination of
the gully erosion.

For example, planting vegetation alongside gullies improves the structural
strength of the soil and makes it harder for the gully to erode any further. An
example is winter grass.

1.9 The drone that is used for quantifying gully erosion
The MetFure project is about developing a method with drones to map furrow
erosion in agricultural soils. So naturally, there is going to be some flying done
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with these drones. There will be made use of the DJI Mavic Pro drones for this.
(Figure 87)

Figure 13 The DJI Mavic Pro drone.

This drone can fly manually and on automatic pilot. It can reach top speeds of 65
kilometres per hour. It can fly for up to 30 minutes at a time. So, bringing extra
batteries when out doing measurements in the field, is essential. More about
measuring with drones in sub-paragraph 1.10.3.

This Drone has a couple of cameras on it. It had one camera on the downside
that is used for landing. There is one bigger camera on the front that is used for
filming and taking pictures. There are also two smaller cameras on the front that
are used for detecting obstacles to prevent the drone from crashing.

I.10 Relevant software
In this paragraph, the relevant software that is used within this project is being
described. These programs are all free except Photoscan pro.

1.10.1 Open LISEM

Open LISEM is a program that has been developed for the mapping and
calculating of erosion. LISEM is an abbreviation for the Limburg Soil Erosion
Model. It is a model that simulates runoff, shallow floods and sediment dynamics
in rural and urban catchments. The model is designed for the management of
disaster risks, the model should not be used for long term estimates. (University
of Twente, 2019) Once a couple of parameters like flowrate, the volume of the
gully and the steepness of the slope are known, it is possible to let this program
run a simulation of the erosion. it will then also calculate things like the amount
of sedimentation and erosion, but also the number of particles and nutrients that
are being taken away by the rill- and gully erosion.

LISEM uses the maps from PCRaster (1.10.6) to simulate the amounts of run off
etcetera. Models that are also utilised in LISEM are the pF curve (water
retention)
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1.10.2 QGIS

QGIS is a program in which one can create maps. The raw data that is obtained
through measurements and calculations can be used in QGIS to get an overview
through a map. First the raw data + coordinates should be put in an Excel file.
Then the data can be read into QGIS to form a map. These maps provide a nice
overview of the calculations that were made.

1.10.3 Precision flight

Precision flight is the App that is used for scanning of the field. This app sets the
route and scanning area of the drone. The app connects with the drone and sets
out the route it needs to fly. The route can be easily set, by drawing a polygon
on a smartphone. The smartphone is then plugged into the controller of the
drone. (Figure 14)

Figure 14 DJI Mavic Pro Drone controller with a smartphone plugged into it.

Once the route is set, the drone is ordered take off and it will take pictures of the
landscape beneath it every few meters. It will continue to do this until the entire
marked area is photographed and measured. The altitude of the drone also is an
important parameter for detail in the image. The higher the altitude, the less
detail in the image, the faster the drone will be finished photographing the area.
If the altitude is lower, then the image will be more detailed, but the drone will
have to make more rounds to measure and photograph the entire area. Finding
the best ratio between the amount of detail and flight time is also a part of the
MetFure Project.
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1.10.4 Photoscan

After the drone has finished photographing and measuring the area, the data is
stored on an SD card on the inside of the drone. The pictures and data should
then be moved onto a computer and be imported to Agisoft Photoscan
Professional. (Photoscan for short)

Photoscan is the program that uses the measurements and data from the drone
to make a 3D model of the area. This 3D model’s detail is very high. (If flown
with a with a low altitude)

When flown with an altitude of about 20 meters. The Picture resolution is about
0,6 centimetres per pixel.

Photoscan can build DEM- and orthomosaic based models. These files can then
be used to make maps and analysis in SAGA or QGIS.

Fun fact: Photoscan Pro costs about 35000 NOK, which is approximately 3500
euros. Photoscan is also used in the videogame industry to make 3D rendered
areas in high detail.

1.10.5 SAGA

After the first 3d model is made, SAGA can be used to adjust image of the area
even further. For example, there is an option where it is possible to add colours
to the differences in height of the area. SAGA is a GIS program that can calculate
with 3D surfaces. For this reason, SAGA will be used for the calculation of the
volume of gullies. SAGA will be used to ready the 3D model from Photoscan for
the quantifying of gully erosion. the 3d model will be modified with this software
to calculate the volume of the gully efficiently.

[.10.6 PCRaster GIS

This program is used as a data source in LISEM. PCRaster is a program that
requires written commands to utilise. PCRaster will be used to make maps of
certain areas like Skuterud or Mgrdre. This is a complex process, so most of the
maps will be provided by the supervisors. These maps can then be used in LISEM
for simulations.

I.11 pF-curve

The pF-curve shows the relation between pressure and water content in the soil.
Also known as the © expressed in m3/m3 and pressure (W4) in the soil. 2
numbers are important here; Wilting point (At a pressure of 1600 KPa) and field
capacity at a pressure height of 10 KPa. The plant available water content is
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between these two values. This is the target value farmers would like to have. In
Figure 15 is an example of a pF curve.
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Figure 15: pF-curve (Eurofins Agro, 2014)

I.12 pF-curve and LISEM

LISEM also makes use of this relationship to calculate if there will be any
ponding. If the pF is 0,0 than that means that the soil is saturated with water. In
this case, when there is a lot of precipitation over time, the saturation of the soil
will cause ponding over the surface. LISEM simulates this process in the form of
maps and charts over a given period. The permeability of the soil (“"k” expressed
in m/day) is also an important factor in this process, as it determines the speed
of that the water will be drained into the soil. Soil types with very small pores,
such as clay, have a very low “k-value”.

LISEM also calculates the k-value of every soil horizon. Then it proceeds to run its
simulation with the given amount of rainfall, amount of water in the soil and the
shape of the landscape. This is how LISEM runs its simulations.
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I.13 How LISEM simulates a catchment

LISEM uses maps to simulate run-off for catchments. LISEM does this by using
cells in the maps with different properties. An example of a map with different
kinds of cells is given in figure 16.

B Aguila - C\Users\mauri\Documents\HAS\HAS jaar \Buitenl...  — O
File Edit View Help

m % &
Ch\Users\mauri\C
| 102
| 103
el
;I 202
—F

Figure 16: Profile-Map of Gryteland (piece of farmland in Skuterud)

The profile map depicts an area in Skuterud with different soil profiles. In this
map are 5 different soil-profiles to be seen: 102 and 103, which are clay-ish
types of soil. 201, 202 and 203 are sandy soils. This map is made up of cells,
with each cell being defined by soil type. The same goes for any other map file in
LISEM. Every map consists of these cells.

Every cell has a description of the soil profile underneath the cell. This can be
interpreted as a column of different soil types. An example of profile type 102 is
given in figure 17.

1Rk8AP

2RK8EgBt

Figure 17 The soil profile of a cell in a map

The soil types are classified in the Norwegian way. The cell types are defined in
the profile.inp file. This is a text-file that LISEM uses to run simulations. This file
always has the same lay-out.

hQ = 27 NIBIO

NORSK INSTITUTT FOR
un |VerS|t BIO@KONOMI

of applied smences



I.14 Important LISEM files.

The files used in LISEM to simulate catchments are called Map-files. These are
maps using cells every few meters. These cells contain all kinds of soil physical
and relevant data. The most important factors (map-files) that need to be
adjusted when simulating a catchment for gully erosion are:

- Crop height (ch.map)

- The leaf area index (lai.map)

- Percentage of vegetation covering the soil. (per.map)

- The soil profile (profile.inp and profile.map)

- Characteristics per soil type, like permeability (The SWATRE tables)

Ch.map

The crop height map describes the height of the crops in every cell of the map.
Crop height is an important factor for making an estimation of the run-off’s
catchment and gully formation. This is because crop height determines the
amount of interception that takes place. A higher crop height means more
interception and less splash erosion. (splash erosion = erosion caused by the
falling of raindrops) (University of Twente, g.d.)

Lai.map

the leaf area index is a map that quantifies the storage capacity of the canopy. If
the value of the map is 6, for instance. Then that means that the vegetated part
of the grid cell has a storage capacity of 6. The value can differ between 0 and
12. (University of Twente, g.d.)

Per.map

The Abbreviation of this map already says it already. The percentage of soil
covered by vegetation. The percentage is displayed in this map as a value
between 0 and 1. So if the soil is covered by 50% of vegetation, then the value
of the cell is 0,5. (University of Twente, g.d.)

Profile.inp and profile.map

This map and file are already explained in paragraph I.13 as an example how the
pcraster-maps work. The profile.inp file offers a description of the soil profile of
each map and uses the SWATRE tables. The profile.inp file has a layout that
describes the type of soil in each soil layer. (University of Twente, g.d.)

SWATRE tables

The SWATRE tables are the tables that contain the characteristics of each soil
type, including permeability (k). When simulating gully erosion in LISEM, it can
come in handy to manually lower the k value in the SWATRE tables. This lowers
the permeability of the soil. This is necessary because in the winter, the soil is
frozen, which prevents most of the water infiltration to the soil. (University of
Twente, g.d.)
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I.15 Stakeholders within the MetFure Project/NIBIO.

NIBIO is an independent organisation that performs research on behalf of the
ministry of agriculture in NIBIO. Because they are independent, there are little
stakeholders that will have an influence on the way NIBIO performs its research.

A few stakeholders are the ministry of research and farmers. NIBIO has no
influence on the practices farmers should perform. But they do have opinions on
matters that can lead to discussions with farmers. These “social dilemma’s”
happen sometimes.

For example, the farmer wants a clear ground to prevent weeds to take nutrients
that could otherwise be consumed by the crops. This also looks tidier in the
agricultural field. This means less vegetation on the soil. Less vegetation
however, means that the soil is more prone to succumb to gully erosion. This is
where the discussions take place within NIBIO and the farmers. It also raises
questions on how much influence weeds have on the crop yield and prevents the
removal of weeds more damage than gully erosion?

Another important stakeholder is the ministry of agriculture and the Norwegian
water authority. These are technically the commissioners of the research that
needs to be performed within NIBIO. These authorities only commission the field
of research, like “more research what causes eutrophication in the area”. NIBIO
then proceeds to further specify the research into set projects like the MetFure
project to develop a method to quantify and map gully erosion. This ultimately
contributes to a better understanding the way gully erosion can be mapped to
monitor the problem. Because gully erosion causes the eutrophication of surface
waters. At the end of the year, NIBIO submits a report to these authorities that
explains what kind of research has been performed.
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Attachment II, Manual for mapping and quantifying gully

erosion.
This is the manual on mapping and quantifying gully erosion using drone
photogrammetry.

II.1 The optimal flight method for drones

The best method to map gully erosion with the drone depends on a couple of
factors. These factors are the altitude of the flight and the type of software used
during the flight.

An altitude of 20 meters gives the best results with the least amount of flight
time. The accuracy while flying with the "DJI MAVIC PRO drone” is about 8 mm
per pixel at this height.

The PrecisionFlight app should be used to map the area where gully erosion
would occur. It is available for free in the App store. The route for mapping gully
erosion is set properly according to the following instructions.

The first step is to start up the app. The first thing seen will be the screen in
figure 18.

Connect your remote controller to fly

Or, plan a flight first

@ PRECISIONFLIGHT

Figure 18, The starting screen.

Connect the phone to the remote controller of the drone. Then, connect the
drone with the remote controller. To connect the drone with the remote
controller, one should press the power button twice, and hold the button down
when pressing for the second time. (this is done with both the remote controller
and the drone.)

Once connected, the flight route can be planned. Select “plan a flight” (or choose
a flight that was already made.). When mapping gully erosion it is important to
select the Grid survey type, as seen in figure 19. This survey type allows the
drone to map an entire area.
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Choose your survey type

Grid

The single grid survey is the standard "lawnmower" pattern used by
early versions of PrecisionFlight. It takes an area of interest (polygon)
as input, and generates a path back and forth to get full coverage.

( Choose )

Figure 19, Selecting the survey type

The settings for the flight plan can now be configured. The altitude, and with it
the resolution of the image, are set by 20 metres. As seen in figure 20.

Skuterud SET Draw —
190424.20m 7 Altitude - 3= ADVANCED X

Area of Interest =

ALTITUDE
Set the altitude of your flight

20 @ 66 ™

meters feet

RESOLUTION

0,6

cm/pixel
~

Figure 20, Setting the altitude of the drone

It is important to keep in mind the drone will fly on the same height from its
point of take-off. So, when dealing with elevated areas, it is mandatory to set the
altitude according to the amount of elevation in the area. For example, when an
area with an elevation of around 10 metres must be mapped, from a lower point
of take-off. It is wise to set the flying altitude to 25 to 30 metres at the lower
starting point to make sure there is enough overlap between the images.

When taking off from a higher point, it is wise to set a lower altitude to ensure
all images still have a good resolution.

After setting the altitude of the drone. The last step is to draw the area of
interest. An example of such a drawing is given in figure 21. When drawing a
polygon, the flight time and amount or lines are estimated. It is important to
bring extra batteries for the drone (or even an extra remote controller) to
prevent the risk of having to cancel the fieldwork because of an empty battery.
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stuterud SET Draw —
19041120m 7 Altitude - eAreauflnterest 3 ADVANCED X

Area: 3,2 hectares, Estimated Flights: 2, Resolution: 0,6 cm/px a

I e « 0
PHECISIGNFL.’GHT Edit Rotate Undo  Delete

\
\

Figure 21, Drawing the area of interest

When the polygon is drawn, make sure there are no obstacles around, such as
trees or other tall things. Take note of the estimated flight time when drawing
the polygon to make sure to map the entire area in as little time as possible.
Having a scan of only the essential area also saves lots of time when generating
an elevation model of the area in Photoscan.

When the polygon is drawn, tap “save” and press the “take off” button and swipe
up. The drone will fly around, and the progress of the flight will be shown on the
app for the remainder of the flight.

After the flight, connect the drone to a computer and export the images to a
preferred folder. From here on, the next step shall take place.
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II.2 Generating an elevation model in Photoscan.
The elevation model is also called a DEM-file. The abbreviation means Digital
Elevation Model. (DEM). Generating a DEM in Photoscan is easy. And the

commands are given throughout a single menu,

“workflow”.

The first step is importing the pictures to Photoscan. To do that, click “workflow”

in the toolbar on the top left corner of screen. Then click “*Add Photos...”

as seen

in figure 22.

H Untitled — Agisoft PhotoScan Professional
File Edit View Workflow Model Photo Ortho

B =]
Workspace
o

TH Workspace (0 ck

rt > metfure » 190429 » Beek Gryteland 30_meter »

v O

Sek i Beek_Gryteland_30_

meter 0

x

[ Add Photos... ~
= m @
“o Add Folder... =)
*  Navn Endringsdato Type Sterrels ™
Align Photos... [ Dii_0209.PG 29.04.2019 12.14 IPG-fil 50
Build Dense Cloud... [& i ozo0urG 29.04.201913.14 IPG-fil 500
Build Mesh DII_0301.0PG 29.04.201913.14 IPG-fil 50
[& on_ozo2apG 29.04.201913.14 IPG-fil 50
Build Texture... DJI_D302.0PG 29042019 12.14 IPG-fil 51
Build Tiled Model... & Di_n30a.spG 29.04.201913.14 IPG-fil 50
Build DEM... DII_305.0PG 29.04.2019 13.14 IPG-fil 510
Build Orthomaosaic [& pi_oao6arG 29.04.2019 13.14 IPG-fil 51
. o - DJI_0307.JPG 29.04.2019 13.14 IPG-fil 51
hibio.nothomeliaas) (H:) =
Align Chunks & pa_ozoslrG 29042019 13.14 IPG-fil
\bioforsk.local.) (K:) @ .
M@l L DJI_0309.0PG 29042019 13.14 IPG-fil
il-12 bioforsk.local.) (M:] & paomioarG 29042019 13.14 IPG-il 1
Batch Process... print01 bioforsk.local) (P:) & paoz11aRG 20042019 13.14 IPG-fil 1
2.39.98.27) (Ck) & piomizieG 29042019 13.14 IPG-fil 51:
(V\biobildeDT.bioforsk.local) (R:) & piomizIeG 20042019 13.14 IPG-fil 51t
Lo s & paoz14apG 20042019 13.14 IPG-fil 1t
& oo oz150pG 20042019 13.14 IPG-fil 51¢
== Prosjekt (\\int.nibio.ne) (T:) = =
- & oo o3160RG 20.04.201913.14 IPG-fil 50y
== Adrn [\int.nibie.no) (V') wlia s
Filnavr: | "DJI_0280.JPG" "DJI_0281JPG" "DJI_0282.JPG" "DJI_0282.JPG" "DJI 0284.JPG" "DJI 0285.JPG" "DJI 0286. v‘ All Formats (*.jpg *.jpeg *jp2 ™. ~
2 oot

Figure 22, (1:) Workflow - Add Photos, (2:) select photos = click "open”.

After the photos are added, the batch process can be set up. This requires the
knowledge of knowing which stept to put in which order.

Click “workflow” in the upper toolbar and select batch proces. The following
menu will appear as seen in figure 23.
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H Untitled® — Agisoft PhotoScan Professional
File Edit WYiew Workflow Meodel Photo Orthe
0 =G Add Photos.. v Order Job Type Applies Te

Workspace o Add Folder... ]

o @M B Align Photos...

.................................................... Build Dense Cloud...
v c““g:r::: Build Mesh...

Build Texture...
Build Tiled Maodel...
Build DEM...

B Batch Process

Build Orthomosaic
Align Chunks...

Merge Chunks...
et | [ Remove

Batch Process... [ save project after each step

1 2 oK Cancel

Figure 23, (1:) By clicking “"batch process” in the workflow tab, (2:) the batch process menu will
appear.

In the batch menu, a couple of tasks are added to complete. This way, one can
avoid having to click continuously to be able to progress with every step in the
calculation. Click “add” to add the first step of the calculation.

The first step is aligning the Photos that have been imported. Select “align
Photos” in Job type. Then choose the accuracy of the alignment in the general-
tab. (As seen in figure 24) Keep in mind that, the higher the accuracy of
alignment, the more time the calculations will take. A high accuracy is
recommended when studying rills in the landscape.

B addJob X
Job type: | Align Photos -
Apply to: | All Chunks hd
Chunk 1 (37 cameras)
Settings:
Property Value
¥ General
Accuracy High
Generic preselection Yes
Reference preselection Ves
v Advanced
Key point limit 40,000
Tie point limit 4,000
Apply masks to Mone
Adaptive camera model fitting  Yes
Cancel

Figure 24, Options for aligning photos

Click "OK"” when the accuracy is chosen. The batch process menu will now
reappear. Click add again to add another calculation step into the process.

The next job that is performed is the generation of a dense cloud. The dense
cloud forms the base of a 3D model of the area. It is a “dense cloud” of
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overlapping points in the photos. As seen in figure 25, choose the job type:
“Build Dense Cloud” in the menu. Then select which quality the dense cloud
should be. Ultra high quality takes a lot of time (sometimes 24 hours when
having a lot of photos) to generate, but provides the best looking image. See
approach, paragraph 3.2.1 for an overview of resolutions with each altitude, and

quality of the dense cloud.

B AddJob

Job type: |Build Dense Cloud

Apply to: | All Chunks

X

-

-

Chunk 1 (37 carneras)

Settings:

Property Value
¥ General

Quality Ultra high -
¥ Advanced

Depth filtering Aggressive

Reuse depth maps Mo

Calculate point colors Yes

Cancel

Figure 25, Building Dense Cloud

Click "OK” when done. The batch process menu will reappear. Select “add...”
again to add the next step in the calculation, Which is “"Build Mesh”. In this step
the 3D model will be generated from the Dense Cloud. It is recommended to
choose for an Ultra high “depth maps quality” when making a DEM later on. (see

figure 26)
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B add ek *

Job type: |Build Mesh d

Apply to: | All Chunks -

Chunk 1 (37 cameras)

Settings:

Property Value

~ General
Surface type Arbitrary
Source data Dense cloud
Depth maps quality Ultra high
Face count High
Custom face count 200,000

~ Advanced
Interpolation Enabled (default)
Point classes All
Calculate vertex colors Yes
Reuse depth maps Mo

Use strict volumetric masks No

cancel

Figure 26, Building Mesh, confirm that the source data is from the Dense cloud.

Click "OK” when done and then add the next job which is “"Build DEM”. The DEM
is generated from the mesh and Dense cloud that were created in the last step.
For the best results, be sure to select the Dense cloud as the source data for this
job, as seen in figure 27.

H EditJob

Job type: |Build DEM

Apply to: | All Chunks

Chunk 1 (37 cameras)

Settings:

Property Value
Source data Dense cloud
Interpolation Enabled {default)
Point classes All
Projection
Resolution (m/pix) 0
v Use custom region Mo
Region minX 0
Regionmin¥ 0
Region maxX 0

Region max¥ 0

Figure 27, Build DEM

Click "OK"” when finished and add the next job. which is “export DEM”. After the
DEM is generated, it will be exported to a folder of choosing.
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[ add Job x
Job type: |Export DEM -
Apply to: | All Chunks =
Chunk 1 (194 cameras, 12 markers, 155,226 points) [R]
Copy of Chunk 1 (194 cameras, 155,226 points) [R]
Settings:
Property Value
Path
Resolution (m) 0
No-data value -32767
Projection WGS 84/ UTMzone 32N (EPSGi3.
Raster transform None
Background color White
Write KML file No
Write World file No
Write tile scheme No
v Splitin blocks No
Block width 1,024
Block height 1,024
v Use custom region No
Region min X 0
Region min ¥ 0
Region max X 0
Region max ¥ 0
Image description
¥ Compression
Wite BigTIFF file No
Generate TIFF overviews Yes
Canca
Figure 28, Export DEM
Bl Edit Job X

Job type: | Build Orthomosaic

Apply to: | Al Chunks

Chunk 1 (37 cameras,
Settings:
Property Value
Resolution (m) 0
Surface Mesh
Blending mode Mosaic
Hole filling Ves
Enable back-face culling Mo
Projection
~ Use custom region No
Region min X 0
Region min ¥ 0
Region max X 0
Region max ¥ 0
Cancel

Figure 29, Build Orthomosaic
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Double click on the empty space, right of the
property; “Path”, and select a place where the DEM
should be saved. (figure 28)

Be sure to select the "WGS 84 / UTM zone 32N
(EPSG:32632)"” coordinates system since it is the
most accurate. This coordinate system is the best for
measuring the length and width of the gullies.

Make sure that the DEM is saved as a .tif image. That
way it can be easily imported into SAGA later on.

The DEM can be all one needs to calculate the
volume of gullies. But sometimes the rills are so
small that they are not visible on the DEM. For this
reason, it can be useful to have a detailed picture of
the area with the rill to pinpoint its exact location on
the DEM. Generating an Orthomosaic can be of help
with this.

Click “add...” in the batch processing menu and
select “"Build Orthomosaic as the Job type. An
example can be seen in figure 29.

Click "OK” and finish the batch process by adding
one last step.
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Click “add...” and select “Export Orthomosaic” in Job type. (see figure 30) Choose
a directory in “Path” and confirm the settings.

B Addicb =
Job type: |Export Orthomosaic -
Apply to: | All Chunks -
Chunk 1 (37 cameras,
Settings:
Property Value
Path M:/Robert/metfure/190429/Beck_..
Resolution (m) 0
Projection
Raster transform None
Background color White
Write KML file No
Write World file No
Write tile scheme No
~ Split in blocks No
Block width 1,024
Block height 1,024
v Use custom region No
Region min X o
Region min ¥ 0
Region max X 0
Region max Y 0
Image description
v Compression
Write BigTIFF file No
Generate TIFF overviews Yes
TIFF compression LzZw
IPEG quality 20
Write alpha channel Yes
Cancel

Figure 30, Export Orthomosaic

Check if all of the jobs in the batch process menu are in the right ordor, as seen
in figure 31. If so, click OK and await the results when the processing is done.
This could take a long time if a large area is being processed in a high quality.

Batch P X
B Batch Process H Processing in progress...
Order Job Type Applies To
1 AlignPhotos  All Chunks Job Procesced Failed
2 Build Dense Clo... All Chunks = Align Photos 0/1 0
3 Build Mesh All Chunks Build Dense...
4 Build DEM All Chunks
5 Export DEM Al Chunks Build Mesh
5 Build Orthomos... All Chunks Build DEM
7 Export Orthom... All Chunks Export DEM
i Build Ortho...
1 Export Orth..,

Detecting points...

8% done, 00:00:20 elapsed, 00:03:27 left

Overall progress:

Add... Edit... Remove =
» Details
[ save project after each step
_ Pause Cancel
OK Cancel

Figure 31, Batch processing menu in the right order and processing menu

For an overview of resolution with each quality and altitude. See approach
paragraph 3.2.
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Now follows an overview of the results from Photoscan and their uses. In figure
32, a depiction of a mesh is given. In this case it is a high-resolution 3D model of
a creek. Here the area can be seen in 3D and in high detail. This also forms the
base layer for the DEM.

sHE-gecsd n-FFIE

Eﬂ“M.aﬁﬂﬁﬂmﬂlm

Figure 32, Mesh, 3D model of a creek.

In figure 33 a depiction of the DEM is given of the same creek. With DEM’s like
these, the volume of gullies, (or this creek for example) can be calculated in
SAGA.

-«:/\m;@qu  [EE 9
i oo @)

GEIO 755555

Figure 33, DEM

The visibility of the creek is good enough to distinguish from the rest of the
landscape. However, in some cases it will not be visible enough. For this reason,
it is good to have an orthomosaic that can be used to compare the DEM to. An
image of an orthomosaic is given in figure 34.
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Figure 34, Orthomosaic

The orthomosaic consists of 4 different layers of data. These four layers will have
to be added in SAGA, if one wishes to compare it to the DEM.
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I1.3 Making cross-sections of a gully

The goal of this step is to compare the conventional measurements to the drone
measurements. To reach this goal, a couple of steps must be taken in SAGA to
convert the DEM into a quantifiable model for gully erosion. This is basically done
using both excel and SAGA.

I1.3.1 Importing the DEM

The DEM that was made in Photoscan needs to be imported to SAGA for further
analysis. This DEM is needed to get cross sections from gullies. Import the Tiff-
image (DEM-file) to SAGA. this can be done following figure 35.

& saca
File | Geoprocessing Window 7

-

: e Load Tool Library

Manai Find and Run Tool *
b
= Climate ?
Database —

S s oo >

Garden 3 GPS Import >
Imagery > Reports > _ Import Binary Raw Data
Projection » Satellite Imagery » Create Raster Catalogue from Files Import CRU Grids
Shapes > Shapes > Create Raster Catalogues from Directory Import ESRI Arc/Info Grid
Simulation > Tables > Import Erdas LAN/GIS
Spatial and Geostatistics » Virtual » Import Grid from Table
TIN > Import Grid from XYZ
Table > Import Grids from KML
Terrain Analysis > Import Image (bmp, jpg, png, tif, gif, pnm, xpm)
Visualization > Import MOLA Grid (MEGDR)
Import NetCDF
o mpetRete
Import SRTM30 DEM

Import Surfer Grid

Import TMS Image

Import USGS SRTM Grid

Import WRF Geogrid Binary Format

Import, Clip and Resample Grids

Figure 35, Geoprocessing = File 2 Grid 2 Import -2 Import Raster.

A new menu will appear in which one can set the file directory to import a DEM

to SAGA.
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Here it is possible to add the DEM file when clicking on the *
in figure 36). Chose the DEM file that is needed and click “open”
“okay” to close the menu and start importing the DEM. This may take several

minutes depending on the size of the file.

... button (see arrow
, and then click

automatic
O
Nearest Neighbour

20_meter_hoog »

Navn -
190411_20meter files
Dwarsdaorsneden_profiel
SAGA
SAGA_Proficlen_DEM

il 190411_20meterDEM_clip.tif

=i/ 1900411_20meterDEM.tiF

il 1900411_20meterDEM_190513.4if

5] 1900411_20meterDEM_clip_DO1.tif

il 1900411_20meterDEM_clip_0005.1if

5] 1900411_20meterOrthomosaic.tif

& pi_ot63PG

& pi_ote4pG

& pi_ot6sIPG

& pi_otesrG

& pi_ot67rG

& pi_otespG

& pi_o169.PG

&l DI NI7NIPG
<

v O Sk i 20_meter_hoog

=~ T

Endringsdato Type

Filmappe
Filmappe
Filmappe
Filmappe
TIF-fil
TIF-fil
TIF-fil
TIF-fil
TIF-fil
TIF-fil
IPG-fil
PGl
IPG-fil
PGl
IPG-fil
PGl
PGl
1PG-fil

" | All Recognized Files

E Options
I
Multiple Bands Output
Sclect from Multiple Bands

=l Transformation
Resempling
& Open
« “ 4 ||« Robert » metfure > 190411 »
Organiser Ny mappe
[ Denne PCen -
| Bilder
%/ Dokumenter
B Musikk
J Nedlastinger
I Skrivebord
B Videoer
| e Lokal disk (C:)
I| = RoBa (\\nibicfil0int.nibio.no\homeT\aas) (H:)
= IM-Aas-felles$ (\fil-07 bioforsk.local.) (K:)
= JM-Aas-Ny felles$ (\\Fil-18 bioforsk.local) (M:)
= Fellessoftware$ (\\bioprint01 bioforsk.local) (P:)
= indeksertebilder$ (\\128.39.98.27) (Q;)
= Ikke_indekserte_bilder$ (\\biobildeD1.bioforsk.local) (R:)
= Databank (\\int.nibio.no) (5:)
= Prosjekt (\int.nibie.no) (T:)
= Adm (Wint.nibio.ng) (V:) v
Files File name: | 1900411_20meterDEM.tif
File path

Starrels A

Cancel

X
»
(2]

L

Save

Defaults

Info >>

Figure 36, Importing the DEM to SAGA

The imported file should look like this (figure 37). This is a DEM of small creek in
Gryteland. The small furrows of the agricultural land are also visible beside the
creek. Rills and gullies sizes can vary from the size of a creek to as small als a

furrow in agricultural fields. For this reason, there is the need to generate a

couple of profiles from the creek and from the furrows next to it in the upcoming

examples.
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(3101, Sk Gotelan.10.meter OEM ==
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Figure 37, The DEM of the creek in Gryteland (Skuterud)

I1.3.2 Creating a point table in excel
The first step is to create points. These points will later be converted into lines.
This line is used to analyse the cross section of a profile of the gully.

These points are given in coordinates. For example, there is a need of 6 cross
sections of a gully’s profile. A table is made with the coordinates of 2 points per
profile, going from one side to the other side of a gully. (see table 5)

Table 5, Coordinates of every profile.

X Y ID

7622,849680 9607,688364 Creek 1
8,946,393170 9537,099378 Creek 1
6,969,901558 7190,015589 Creek 2
8,311,092295 6907,659645 Creek 2
6,281,658944 4860,579047 Creek 3
7640,496927 5260,572664 Creek 3
10358,172893 7842,963711 Furrow 1
10905,237536 7648,843999 Furrow 1
9,969,933469 6378,242249 Furrow 2
10499,350865 6148,828044 Furrow 2
9369,927087 4754,695567 Furrow 3
9934,638976 4542,928609 Furrow 3

An important thing is to make sure that the coordinate system in this table is
“"WGS 84 / UTM zone 32N (EPSG:32632)". This coordinate system is the most
accurate and is best for measuring small things in the landscape like gullies and
rills. Usually the table looks like the example, table 5. Adding an ID to all
coordinates provides more overview and will come in handy in future steps.

It is essential that this table is saved as a csv-file when done working on it in
Excel. The columns will be divided by “;” tokens.
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I1.3.3 Importing the point table to SAGA
This table can now be imported to saga as a table. Follow the instructions in
figure 38 to add a table to SAGA

& saca
File Geoprocessing Map Window 7
L Load Tool Library B X | Sp Ea O~ J
Manai  Find and Run Tool
%
Climate ? { [ 01. Beek_Gryteland_10_meter DEM |
— Database > ‘ 4?33 -Z‘r?DD =2000 -1000 o 1000 2000 3000 4000 5000 8000 1
= File > ESRI E00 >
- Garden > GPS Import »
Grid > Grid >
Imagery > Reports >
Projection > Satellite Imagery >
Shapes > Shapes »
Simulation > Tables » Export > |
Spatial and Geostatistics > Virtual > Import > Import Text Table
TN > Import Text Table (Fixed Column Sizes)
Table > Import Text Table with Numbers only
Terrain Analysis > Import Text Tables
Visualization >
Import Raster

Import Image (bmp, jpg, png, tif, gif, pam, xp)
Convert Table to Points
Import Text Table

o mo00 o0 vo0o0  veoo

Figure 38, Click Geoprocessing 2 File = Tables - Import - Import Text Table

The next menu, as shown in figure 39, will appear. Here the directory to the
table.csv file needs to be set. Select whether the table contains a headline or
not, to make sure every piece of information will be processed. Also, be sure to
select the right separator token. In csv files this is usually “;”. Click okay when
everything is set.

Import Text Table X
e
E Tables
<< Table <create> Cancel
5) Options
Headline
Separator : Load
ave
Defaults
Info >>

Figure 39, Importing a table to SAGA.

The goal of this table is to convert the coordinates in it into points on the map.
This can be done easily as seen in figure 40.
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& saGa
File Geoprocessing Map Window 7
B Load Tool Library E|\@J§"§'g|3nﬁ]|r--‘|

Mana; Find and Run Toal

Climate [ 01. Beek Gryteland_10_meter DEM
Database || -4000 3000 2000 -1000 [

File
Garden
Grid
Imagery
Projection

Shapes Construction

Simulation Conversion Convert Lines to Points

Spatial and Geostatistics Lines Convert Lines to Polygons

TIN Point Clouds Convert Multipoints to Points

Table Points Convert Points to Line(s)

Terrain Analysis Polygons Convert Polygon/Line Vertices to Points
Visualization Selection Convert Polygons to Lines

Shapes-Grid Tools Convert Table to Points

Table Convert Vertex Type (2D/30)

Import Text Table
Import Raster

Import Image (bmp, jpg, png, tif, gif, pnm, xpm) Tets

Convert Table to Points

Figure 40, Click: Geoprocessing 2 Shapes 2 Conversion = convert Table to Points.

Double click on the points in the left side of the screen, and add them to a map
layer. Two points should be visible at each side of a gully or rill. An example is
given in figure 41.

Figure 41, The points are placed with the gully between them.

To get a cross section of the profile of a gully, it is necessary that the points
should be converted into lines to analyse the profile with. This is done as shown
in figure 42.
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& SAGA
=
Wana;
g
Data
B
-1
-1

File | Geoprocessing Map Window 7

Load Tool Library
Find and Run Tool

Climate
Database

File

Garden

Grid

Imagery
Projection
Shapes
Simulation
Spatial and Geostatistics
TIN

Table

Terrain Analysis

Visualization

Convert Points to Line(s)
Convert Table to Paints
Import Text Table
Import Raster

Import Image (bmp, jpg, png, tif, gif, pnm, xpm)

E| % G0 & | 3p B

g4

[ 01, Beek_Gryteland_10_meter_DEM

W W v v v Y v v v e v v

| ‘ 0 1000 2000 el

g

g8
Construction >
Conversion b Convert Lines to Points
Lines > Convert Lines te Polygons
Point Clouds > Convert Multipoints to Points
Points ¥ Convert Points to Line(s)
Polygons 1 Convert Polygon/Line Vertices to Points
Selection > Convert Polygons to Lines
Shapes-Grid Tools > Convert Table to Points
Table > Convert Vertex Type (20/3D)
Tools >

-

=

Figure 42, Geoprocessing 2 Shapes = Conversion - Convert Points to Lines.

A new menu appears like the ones before. (figure 43)

(Convert Points to Line(s)

= Data Objects

X

= Shapes
<< Lines <create> Cancel
T - 3]
Order by... <not set>
Separate by... I <not set> I Load
Elevation <not set>
Save
Defaults
Info ==

Figure 43, Set the group of points to convert and separate them by ID.

The points need to be selected. Set the point layer in the “>> Points” row. After
doing that, it is possible to separate points by ID. Therefore, giving ID’s to the
coordinates is important, as seen in table 5. Click on the empty row of “Separate
by...” and select the attribute the lines should be ordered.

Double click the line shape in the left side of the screen to add them to a map
layer. The lines between the points with the same ID should appear and should
look like the example in figure 44.
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Figure 44, New lines have been added over the furrows.

The lines should cross the gullies in this situation. This allows one to make a
profile analysis of the part of the gully where the line is. Go to: Geoprocessing >
Terrain analysis - Profiles - Profiles from Lines. A new menu should appear as
seen in figure 45.

Profiles from Lines

= Data Objects
= Grids
= Grid system 1; 14612x 14551y; 0.5x 0.5y
»>> DEM 01. Beek_Gryteland_10_meter_ DEM
> Values 1 object (Beek_Gryteland_10_meter_DEM)
= Shapes
[l > Lines 01, Coordinaten_punten_profielen_Gryteland_beek
Name <not set>
< Profiles <not set>
=l Options
=

Figure 45, Selecting the necessary things for the analysis of the profile from the lines.

First, select the grid system that needs analysing. Within the grid system is the
DEM that was imported to SAGA. Select that DEM in the “>> DEM” row. Then

select the DEM again in > Values”. This can be done by double clicking on the
row in next to "DEM > Values” and putting the attribute to the right part of the
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screen in the menu that follows. (figure 46)

<
<

Up

Down

*
[ 01. Beek_Gryteland_10_meter_DEM | Okay |
Cancel

Figure 46, Click the [>] button to select the data from the DEM in the profile analysis.

Now, select the lines that need to be used for the analysis and check the box in
the row that says: “Each Line as new Profile” since one table with each profile
will come in handy (figure 45). Click okay when done.

New profiles should appear in the left part of the screen, as seen in the red
marking in figure 47. The attribute tables within these

& sAGA
File Geoprocessing Map Window 7

FHEDERe s 2iesss

Manager

% Tools = Data @ Maps
Tree B2 Thumbnails

X

Jata

By Grids

;IE 1: 14612 14551y: 0.5x 0.5y

¢ L. 01. Beek_Gryteland_10_meter DEM
1. 108 1; 27836x 28167y; 0.5% 0.5y

T 1; 935 8411y; 0.5¢ 0.5y

= Shapes

l N Line
,N’ 01. Coordinaten_punten_profielen_Gryteland_beek
= Point

01. Coordinaten_punten_profielen_Gryteland_beek
14, Beek_Gryteland_10_meter_DEM [Profile 1]
15, Beek_Gryteland_10_meter_DEM [Profile 2]
16. Beek_Gryteland_10_meter_DEM [Profile 3]
17. Beek_Gryteland_10_meter_DEM [Profile 4]
18. Beek_Gryteland_10_meter_DEM [Profile 3]
%% 19, Beek_Gryteland_10_meter DEM [Profile €]
% Tables

----- ... 01. Coordinaten_punten_profielen_Gryteland_beek

Figure 47, The overview of data, shapes and tables in SAGA.

To view the attribute table, see figure 48.
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[ o umn ——m
Beek_Gryteland_10_meter_DEM [Profile 1]

Close

Add to Map

Save

Save as...

Spatial Reference

Histogram

Classify
Import Classification

Copy Settings from other Layer

Attributes bl Attributes
Edit » Show
" = Diagram
2 Scatterplot

Save Attributes as...

Figure 48, Right click the profile = Attributes - Show.

The attribute table will show with data about the profile, as seen in figure 49.

[ 01. Beek_Gryteland_10_meter DEM [Prfile 1] ==

LINE_ID ) DIST  DIST_SURF X ¥ z rteland_10_my

1 0 1 0 0 8045 9537 5443062 -5.443082
2 0 2 1001397 1001402 9045 053705287 -5.446000  -5.446200
3 0 3 2002793 2.002801 8044 953710574 -5.448505  -5.448505
4 0 4 3.00419 3.0042 8043 953715861  -5450641  -5.450641
5 0 5. 4005587 4005617 8042 953721148 -5457081  -5.457081
6 0 6 5006083  5.007048 9041 053726435  -5.465326  -5.465326
7 0 7 600838 6.008477 9040 9537.317221) 5473358  -5473358
8 0 8 7.009777 7.00994 8939 9537.370091  -5.484934)  -5.484934
9 0 9 8011173 80118 8038 9537422961  -5.499858  -5.499858
10 0 10 901257 9.012865 8037 9537475831  -5.506159  -5.506150
1 0 11 10013966 10.014269 9036 0537.520701  -5.510103  -5510103
12 0 12 11015363 11.015678 9035 9537.581571  -5515134  -5515134
13 0 13 1201676 12017122 8034 9537.634441  -5.524819  -5.524819
14 0 14 13018156 13.018527 8933 9537.687311  -5.528066  -5.528966
15 0 15 14019553 14.019974 8932 9537740081 -5.538064  -5.538964
16 0 16 1500085 15.021381 8031 9537.793051 -5.5437 -5.5437
17 0 17 1602236 16.022793 9030 9537.845021)  -5.540044) 5540044
18 0 18] 17023743 17.024195 8029 9537.808792  -5.552247  -5.552247
19 0 19 1802514 18.025593 8028 9537.951662  -5.550558  -5.550558
20 0 20 1902653  19.026991 8027 9538004532  -5.552454)  -5552454
21 0 21 20027933 20028391 8026 0538057402  -5555077  -5555077
22 0 22| 2102933 21020793 9025 9538110272  -5.558347  -5558347
23 0 23| 22030726 22031202 8024 9538163142  -5.563265  -5.563265
24 0 24 23.03133 23.0326 8023 9538216012  -5.564712  -5.564712
25 0 25 2403350 24033997 8020 953868882  -5.565575  -5.565575
26 0 26| 25034916 25035303 8021 0538321752  -5.565551  -5.565551
27 0 271 26036313 2603679 8020 9538374622  -5.566533  -5.566533
28 0 28 27.037709 27.038198 8919 9538427492  -5.571146  -5571146
29 0 29 28039106 28039595 8018 9538480363  -5.572407  -5.572407
30 0 30| 29040503 29.040992 8917 9538533233  -5.572358  -5572358
31 0 31| 30041808 30.042389 9016 0538586103  -5.573333  -5573333
32 0 32 304329 31043792 8915 9530633073  -5.577012 5577012
33 0 33 32044693 320452 8914 9538.691343 -5.5818 -5.5818
34 0 34 33046089 33.046598 8913 9538744713 -5583341  -5.583341
35 0 35| 34047485 34047998 8912 9538797583  -5.585736  -5.585736

Figure 49, Attribute table of a profile.

This table contains coordinates of every few centimetres (X and Y) and the depth
of every point (Z). The distance over the surface (DIS_SURF) has been
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calculated already using Pythagoras’s formulae with the coordinates. The
attribute tables of these profiles must be saved as txt-files. Right click the
profiles again, select attributes and then select “save attributes as...” (figure 50)

Beek_Gryteland_10_meter DEM [Profile 1]

Close
Add to Map

Save
Save as...
Spatial Reference
Histogram
Classify . i
Import Classification
Copy Settings from other Layer
Attributes » Attributes
Ei‘t . > Show
Py s Diagram
B Scatterplot
Save Attributes as...
——

Figure 50, Right click on profile 2 Attributes 2 “"Save Attributes as...”

The next step is applying a geometrical calculation to the table to make a cross
section of the profile of the gully. This is explained in paragraph I1.4

I1.4 Detrending a gully profile.

The goal of this step is to create a cross section of a gully profile to compare to
conventional measures, this is an optional step. This step is performed in excel
and it is shown in this chapter how it should be done. Paragraph 4.2 provides
some theoretical insight on the formulas that are used in this step.

In this paragraph, it is explained how to use the calculation steps from paragraph
4.2 in excel. This calculation will lead to a detrended cross section of a gully’s
profile. When both the conventional measurement and drone measurements are
detrended. It is possible to compare both these measurements with each other
to check the accuracy of the drone in relation to the real situation.

The first step is opening the attribute tables that were saved as txt-files in Excel.
This can be done via File > Open > Browse - selecting the appropriate file and
clicking open. A couple of Errors can be given about the way the txt-file should
be displayed in Excel. Click next in this message to see how the data will be
displayed. If no data is jumbled, click on “finish”.

The attribute table should have about the same layout as figure 51
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H %-
HIEM

SETT INN SIDEQOPPSETT FORMLER DATA SE GIENNOM VISNING

? F ,__| \/I [o @ store I?-? \If:v -\.):w |

Pivottabell Anbefalte Bilder Eilder ps Figurer Smartdrt Sermbide gy aps - Anbefate WA i gl
pivattabeller Internett - VAP T fiagrammer W 7 1 -
Tabeller INustrasjoner Tillegg Diagrammer
1 - fe
A B C D E F G H |

1 |LINE_ID ID DIST DIST_SURF X z Beek_Grytel DIST_SURF
2 1 1 o 0 603194,469 6616231,36 -1,052294  -1,052294 0
3 1 2 0,007021 0,011694 603194,476 6616231,36 -1,042942 -1,042942 0,011694
4 1 3 0,014043 0,018935 603194,483 6616231,36 -1,041173 -1,041173 0,018935
5 1 4 0,021064 0,026293 603194,489 6616231,36 -1,038573  -1,038973 0,026293
6 1 E 0,028085 0,033315 603194,496 6616231,37 -1,035009  -1,039009 0,033315
7 1 6 0,035107 0,040355 603194,503 6616231,37 -1,038485  -1,038485 0,040355)
8 1 7 0,042128 0,047471  603194,51 6616231,37 -1,037329  -1,037329 0,047471]
9 1 8 0,049143 0,054519 603194,516 6616231,37 -1,036717 -1,036717 0,054519
10 1 9 0,056171 0,061651 603194,523 6616231,37 -1,035466  -1,035466 0,061651]
n 1 10 0,063192 0,0683833 603194,53 6616231,37 -1,033954  -1,033954 0,068833
12 1 11 0,070214 0,075892 603194,537 6616231,38  -1,034675  -1,034675 0,075892
13 1 12 0,077235 0,083167 603194,543 6616231,38 -1,036581  -1,036581 0,083167
14 1 13 0,084256 0,090645 603194,55 6616231,38 -1,039153  -1,039133 0,090645
15 1 14 0,091278 0,097838 603194,557 6616231,38 -1,040717 -1,040717 0,097838

Figure 51, Attribute table imported to Excel.

Next to the standard columns in the table, some additional labels will be added
for the calculation steps. As seen in figure 52.

A B C D E F G H 1 J K L M N
1 |LINE_ID D DIST DIST_SURF X Y z Beek_Grytel DIST_SURF correctieZ detrend | tan (0/A) 0
2 1 1 0 0 603194469 6616231,36 -1,052294 -1,052294 0

Figure 52, Copy DIST_SURF column to the I-column, and add the correction Z column, detrend
column and save an empty cell for the calculation of the tangent.

After the labels for the new columns are added, the first calculation can begin.
The goal of this calculation is to make sure that the chart of the cross section of
the gully will start at zero. The formulas in Excel should look like figure 53.

H | J H | J
4 DIST SURF correctie Z z DIST_SURF  correctie Z
| _1,052294] | -1,052294 0 0
 ———

2| -1,042942 0,011694)=

Figure 53, Applying a new starting value for Z.

Make sure the formula is copied and pasted across the entire table using the
down-right corner of the cell and dragging it to the end of the column. When this
is done, one can calculate the tangent with the formula:

opposite side  corrected Z value
~ DIST_SURF (distance)

T t=
angen adjecent side

The formula is utilised using the last values of the attribute table, as shown in
figure 54.
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Figure 54, Calculating the tangent with the values from the attribute table. (tangent = O/A)

After the tangent has been calculated, the detrended model can be calculated

HIEM

TILFELDIG...

LINE_ID

Arbeidsbokvisninger

R e R R R R R e R R R R R A R R R R i R R R e R R N R R R R i R i R R R N R R ]

D

SETT INMN

SIDEQPPSETT

X o fr| 217137

B

c
DIST

7,667321
7,674342
7,681364
7,688385
7,695406
7,702428
7,709449
7,71647
7,723492
7,730513
7,737534
7,744556
7,751577
7,758598
7,76562
7,772641
7,779663
7,786684
7,793705
7,800727
7,807748
7,814769
7,821791
7,828812
7,835833
7,842855
7,849876
7,856897
7,863919
7,87094
7,877962
7,884983
7,892004
7,899026
7,906047
7,913068
7,52009
7,927111
7,934132
7,941154
7,948175
7,955196
7,962218
7,969239

with the formula:

Detrended point = Corected Z value of specific point — Tangent * Distance over surface

In short this is:

The same formula will now be used in Excel to create detrended values of the

D
DIST_SURF

10,017411
10,024476
10,031645
10,038691
10,045713
10,052734
10,059756
10,066875
10,075526
10,082573
10,089861
10,09724
10,104374
10,11354
10,120789
10,127831
10,135693
10,142773
10,149794
10,156836
10,163884
10,171139
10,179115
10,186191
10,193212
10,201101
10,208807
10,218876
10,228351
10,235401
10,246756
10,257479
10,265212
10,275582
10,283347
10,290502
10,297601
10,304631
10,311697
10,319347
10,326677
10,333875
10,341183
10,348228

Detrend = Correction Z — Tangent * DIST_SURF

X

FORMLER DATA

603201,837
603201,843
603201,85
603201,857
603201,864
603201,87
603201,877
603201,884
503201,891
603201,897
603201,904
503201,911
603201,918
603201,924
603201,931
603201,938
603201,945
603201,951
603201,958
603201,965
603201,972
603201,978
603201,985
603201,992
503201,999
603202,005
603202,012
603202,019
603202,026
503202,032
603202,039
603202,046
603202,053
603202,059
603202,066
603202,073
603202,08
603202,086
603202,093
603202,1
603202,107
603202,113
603202,12
603202,127

SE GJENNOM

6616233,48
6616233,48
6616233,48
6616233,49
6616233,49
6616233,43
6616233,49
6616233,43

6616233,5

6616233,5

6616233,5

6616233,5

6616233,5
6616233,51
6616233,51
6616233,51
6616233,51
6616233,51
6616233,52
6616233,52
6616233,52
6616233,52
6616233,52
6616233,52
6616233,53
6616233,53
6616233,53
6616233,53
6616233,53
6616233,54
6616233,54
6616233,54
6616233,54
6616233,54
6616233,55
6616233,55
6616233,55
6616233,55
6616233,55
6616233,56
6616233,56
6616233,56
6616233,56
6616233,56

VISNING

Zoom

z
-1,368485
-1,369269
-1,370718
-1,371311
-1,371289
-1,371318
-1,371352
-1,372529
-1,367475
-1,368071
-1,366116
-1,363849
-1,362582
-1,35669
-1,354887
-1,354351
-1,350814
-1,349906
-1,349962
-1,350491
-1,35111
-1,352934
-1,349149
-1,350021
-1,350101
-1,353696
-1,356871
-1,364089
-1,370451
-1,371078
-1,380003
-1,388108
-1,391347
-1,398978
-1,402294
-1,403669
-1,404717
-1,404373
-1,40517
-1,408206
-1,410312
-1,411897
-1,413922
-1,414497

-1,368485
-1,369269
-1,370718
-1,371311
-1,371289
-1,371319
-1,371352
-1,372529
-1,367475
-1,368071
-1,366116
-1,363849
-1,362582

-1,35669
-1,354887
-1,354351
-1,350814
-1,349906
-1,349962
-1,350491

-1,35111
-1,352934
-1,349149
-1,350021
-1,350101
-1,353696
-1,356871
-1,364089
-1,370451
-1,371078
-1,380003
-1,388108
-1,391347
-1,398978
-1,402294
-1,403669
-1,404717
-1,404373

-1,40517
-1,408206
-1,410312
-1,411897
-1,413922
-1,414497|

table. An example can be seen in figure 55.
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Ordne

alle

|
DIST_SURF
10,017411
10,024476
10,031645
10,038691
10,045713
10,052734
10,059756
10,066875
10,075526
10,082573
10,085861
10,09724
10,104374
10,11354
10,120789
10,127831
10,135693
10,142773
10,145794
10,156836
10,163884
10,171135
10,179115
10,186191
10,193212
10,201101
10,208807
10,218876
10,228351
10,235401
10,246756
10,257479
10,265212
10,275582
10,283347
10,290502
10,297601
10,304631
10,311697
10,319347
10,326677
10,333875
10,341183
10,34822,

J

0,316191
0,316975
0,312424
0,319017
0,318995
0,319025
0,319058
0,320235
0,315181
0,315777
0,313822
0,311555
0,310288
0,304396
0,302593
0,302057
0,29852
0,297612
0,297662
0,298197
0,298816
0,30064
0,296855
0,297727
0,297807
0,301402
0,304577
0,311795
0,318157
0,318784
0,327709
0,335814
0,339053
0,246684
0,35
0,351375
0,352423
0,352079
0,352876
0,355912
0,358018
0,359603
0,361628
0,362203

Profiles_20m_Gryteland.xsx - Excel
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TILFELDIG... ~ X o fv | s
A B c D E F G H [ J K L M N

1luNED D DIST DIST_SURF X Y z Beek_Grytel DIST_SURF _correctieZ _detrend tan (0/A) | 0,03500145]
2 1 1 0 0 603194,463 6616231,36 -1,052294 -1,052294 0 0 o 1 1
3 1 2 0007021 0,01165% 603194,476 661623136 -1,042342 -1,042942  0,011694] -0,009352/=2-N51713 |

4 1 3 0014043  0,018535 603194,483 6616231,36 -1,041173 -1041173  0,018535 -0,011121 —0,01178375

5 1 4 0021064 0026293 603194489 661623136 -1038973 -1,038973  0,026293 -0,013321 -0,01424129

6 1 5 0028085 0033315 603194496 661623137 -1,039009 -1,039009  0,033315  -0,013285 -0,01445107

7 1 6 0035107 0,040355 603194,503 6616231,37 -1038485 -1038485  0,040355 -0,013809 -0,01522148

8 1 7 0082128  0,047471 60319451 661623L,37 1037329 ~-1,037329  0,047471  -0,014965 -0,01662655

9 1 8 0049149  0,054519 603194,516 6616231,37 -1,036717 -1036717  0,054519  -0,015577 -0,01748524

10 1 9 0056171  0,061651 603194,523 661623L,37 -1,035466 -1035466  0,061651 -0,016828 -0,01898587

1 1 10 0063192 0068833 60319453 661623137 -1,033954 -1,033954  0,068833  -0,01834 -0,02074925

12 1 11 0070214 0075892 603194537 661623138 -1034675 -1034675  0,075892  -0,017619 -0,02027533

13 1 12 0,077235  0,083167 603194543 6616231,38 -1036581 1036581  0,083167 -0,015713 -0,01862397

Figure 55, Calculation of detrended values

The correctness of the calculation can be checked, if the first and last value of
the detrend column is 0, then this means the slope of the area around the gully
has been removed. The profile of the gullies should look figure 56 this if a chart
is made of the data in Excel.

1
0,5
0§ "
0 2 3 6 g 10 12
0,5

Figure 56 Chart of gully profiles. Blue = original gully with slope, Orange = detrended gully.

Naturally the graph should be inverted for a more realistic display of the gully.
This can be done in Excel as well. With the surface around the gully flattened,
is possible to measure the depth of the gully exactly compared to the ground
level.

I1.5 Calculating gully’s volume

For this step, SAGA is going to be used. Here, the volume of the gully is going to
be calculated. This is done by creating two map layers of the area, a layer with
filed sinks (except for the gully) and a completely flattened area. These two
areas will then be subtracted from each other to get the areas volume. In figure
57, the schematic representation is given of this calculation.
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Figure 57, The rill is marked, a buffer is around it with hill shading from the DEM.

& SAGA [C:\Users\mauri\Documents\HAS\HAS jaar 3\Buitenlandse stag
(@ File Geoprocessing Map Window 7

P EERe % P 0®gg®ﬁ\

Manager
% Tools = Data Maps
p:
Tree | B8 Thumbnails

& Data
=By Grids
-1 original DEM

{::4J01. Original DEM

<

Properties: 01. Original_DEM

B History B Ltegend [ Attributes
I settings @ Description
E Options ~

X

[ General

Description

Memory Handling

=] Disp

Normal

Name Original_DEM

No Data -99999; -09999
=1 Show Legend
Style vertical
Unit metre
Z-Scale 1
Z-Offset 0
Show Cell Values O

The flat DEM will be subtracted from the zone in the
buffer to get the gully’s volume.

The first step here to calculate the gully’s volume is
the importing of the DEM of the area. This is already
explained in paragraph 4.3.1.

It is recommended to give each layer a recognisable
name, otherwise it will be hard to remember which

layer which step in the calculation is. This is shown in
figure 58.

Figure 58, In the red square, it is possible to change a layer’s name.

has

umverS|t

of applied SCIences

>4 NIBIO

NORSK INSTITUTT FOR
BIO@KONOMI



I1.5.1 Analytical hillshading

To get a better visual of the bumps, crevices and rills/gullies, one can apply
analytical hillshading to the DEM. Simply click on Geoprocessing - Terrain
Analysis - Lightning = Analytical hillshading. This process should then be
applied to the original DEM in the next menu. The result can be seen in figure 59.

Figure 59, Analytical hillshading of the DEM.

Analytical hillshading allows for a good overview of the rill in the area. The rill
can be seen within the red circle if looked at closely.

I1.5.2 Clipping the DEM

When the imported DEM has been clipped, the area the calculations should be
done in becomes much smaller. This results in less calculation time. To clip the
DEM, a shape is needed. This shape can be added via geoprocessing >
Construction > Create New Shapes Layer.

This opens a new menu. Choose a name for the shape and select “polygon”
the shape type. Click “okay” when done. A new shape layer will appear in the
data tree on the left side of the screen. Double click on the new shape layer to
add it do the DEM.

Now click the “action” cursor icon to start drawing a polygon around the rill or
gully. (figure 60)

& SAGA [M:\Robert\metfure\rapport\Manual Maurice\methode, volumeberekening..sprj] - [02. Analytical Hillshading
@ File Geoprocessing Map Window 7

wHEBEERe %2 dossevE ko e omB|—4

Figure 60, the location of the action cursor in the upper toolbar.

The analytical hillshading layer may provide insight on the location of the gully
than the DEM. After the polygon is drawn, “right-click” to finish drawing. Right
click on the shape layer of the polygon, click edit, and then uncheck edit
selection to finish editing. The polygon will now appear as a filled shape.
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Now the clipping of the DEM can start. Click Geoprocessing - Shapes-Grid Tools
- Spatial Extent = Clip Grid with Polygon. A new menu will appear, as shown in
figure 61.

X

= Data Objects
= Grids
1= Grid system 0.012853; 10679x 11493y; 632950.823620x 6668019.3 Cancel
1 abject riginal DEMD
= Shapes
=> Polygons 04, Clip DEM Load
= Options

Save
Target Extent polygons

Defaults

Info <<

Figure 61, Select the grid system with the original DEM in this menu, also select the polygon to clip
the DEM with.

Click okay when done setting the inputs. The A new layer will appear in the right
screen. This is the clipped DEM. It is also possible to clip other grid layers the
same way.

I1.5.3 Resampling the DEM

The first step is to resample the original DEM. Resampling basically means
setting a new resolution for the DEM by making the pixels bigger. By increasing
the size of the pixels, the different heights per cell will be flattened according to
the average height of the multiple pixels the new pixel will envelop. The bigger
cells will then be resampled again to their former size, but they will keep the
same values in these cells. Figure 62 depicts this process schematically.

4,314,3 4,3

Resampling Resampling

4,3 4,314,3|4,3

4,314,3 4,3

Figure 62, Resampling a 9 DEM cells into 1 DEM-cell (making it bigger) creates a new average
value per cell, flattening the surface, resampling it back to the last resolution will keep the same)

The second Resampled DEM will be subtracted from the original DEM-part with
the gully/rill. This will present us with the gully’s volume.

To do this in saga, go to the Geoprocessing tab, click Grid, Grid System, and
then “Resampling” (figure 63)
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Geoprocessing  Map  Window 7
Lead Tool Library
Find and Run Tool

B4

S h|RDMa m
x |6330|9

||

Analysis

Climate

6668007

Database
File
Garden
Grid
Imagery
Prajection

106.8

Calculus
Distances
Shapes Filter
Simulation

Spatial and Geostatistics
TIN

Table

Gaps
Grid System
Gridding

Tools

Aggregate
Clip Grids
Clip Grids [interactive]

R R R

Terrain Analysis Walues Create Grid System

vow v v v v v v v v v v v v

Wisualization Crop to Data

Mosaicking
Resampling
Tiling

66680044

Transpose Grids

ki

Figure 63, Geoprocessing = Grid - Grid System - Resampling.

A new menu will appear, as shown in figure 64. Here a couple of options need to
be adjusted.

Resampling

1. Select the grid system of
the original clipped DEM here

= Data Objects
B Grids
= Grid system
> > Grids
) Options
Preserve Data Type O
Upscaling Methed
[=I Target Grid System

original DEM ————

1 object (Original_DEM) ~_

2. Select the object to analyse

from the grid layer here. In this

Len 2550 case, this is the clipped DEM. (By

Bt 6660019.3405308006331325 moving the object to the right
side of the screen in the sub

Mean Value (cell area weighted)
user defined

Top 6668167.0437392007219791
Columns 106728
Rows 11483

Fit nodes

3. Modify the cell size to a
suitable size. The rill in this
case is 10 cm wide, so 0.3 m
should be enough to overlap
the rill with cells after
resampling.

Cellsize
Floating point

Minimum: 0.000000
Default: 1.000000

Figure 64, Resampling menu.
After these steps are completed, click "Okay”.

A new layer will appear on the right side of the screen. Be sure to name it
accordingly. “Resample DEM 1", for example.

Now the resampled DEM needs to be resampled back to its original resolution to
be able to successfully subtract the two DEMs from each other later to get the
volume of the gully. This can be done by opening the resampling menu again and
select “grid or grid system” at Target Grid System. And then select the grid
system that contains the original DEM with the original resolution.

Click okay to resample the resampled DEM back to its original resolution. (just as
depicted in figure 64)
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I1.5.4 Filling sinks (Planchon/Darboux, 2001)
This is @ method in saga that can be used to fill sinks in the area. To access this
method, follow the instructions in figure 65.

Geoprocessing | Map  Window 7
Load Tool Library G| R -
Find and Run Tool x
Climate >
Database L -
Fle ’ ] 01. Mordre_2DEM
Garden 4 | 3220 812340 832580 832580 83301
Grid >
Imagery >
Projection >
Shapes >
Simulation >
Spatial and Geostatistics >
TIN >
Table >
Terrain Analysis > Channels >
Visualization > Climate and Weather >
Resampling [Rielzzy i
Lighting >
Morphometry >
Preprocessing > Burn Stream Network into DEM
Profiles > Fill Sinks (Planchen/Darbouy, 2001)
Slope Stability > Fill Sinks (QM of ESP)
iies: 01, Morare_z0Em Terrain Classification > Fill Sinks (Wang Liu)
History _n Legend [ Attri Basic Terrain Analysis Fill Sinks XXL (Wang Liu)
I settings & Description < Flat Detection
ptions " H Sink Drainage Route Detection
I General = Sink Removal

Figure 65, Geoprocessing =2 terrain Analysis = Pre-processing = Fill Sinks (Planchon/Darboux,
2001)

A new menu will appear as shown in figure 66. Here the original DEM should be
selected as the grid to process.

-1 Data Objects Okay
=l Grids
=| Grid system 0.012853; 10679x 11493y; 632950.8: Cancel
=< Filled DEM <create>
= Options Load
Minimum Slope [Degree] 0.01
Save
Defaults
Info <<

Figure 66, In this menu the clipped DEM from paragraph 4.5.2 should be added.

After the clipped DEM has been added, click on “okay”.

The filling of the sinks in this DEM may take some time because it is a complex
algorithm. This algorithm fills the little holes in the DEM, this way these holes will
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not come up in the volume calculation of the rill. The rill itself will not get filled
because the rill is not a hole but a crevice.

I1.5.5 Downslope area function

This function marks the lowest point of slopes in the area. With this function, a
grid can be created marking the lowest point in the area where all the water
accumulates. In this case it is a rill of the area. To make this grid, go to
Geoprocessing = Terrain Analysis > Hydrology - Flow Accumulation -
Downslope Area [interactive]. The following menu will appear, as shown in figure
67.

Llata Ciyjects
Grids
Grid system 0.01.2853; 1230= 189%6y: 633020.523812x
» > Elevation 02, onginal DEM chpped [no sinks]
» Sink Foubes 02, ariginal DEM clipped [no sinks)
<create>
CPpleins
Methad Dietesrninestic 8
Comvengence 1.1

Figure 67, Select the correct grid system that contains the clipped DEM and select the clipped DEM
in the Elevation row and Sink Routes Row.

Click okay when finished.

The interactive tool for downslope area is how activated. Choose the action
cursor from the top toolbar in SAGA. Click at the starting point of the gully or rill
to generate a line that follows the accumulation of water in the rill. Deactivate
the tool by clicking on geoprocessing and unchecking the downslope area tool.

The down slope area layer in the left side of the screen should look like figure 68.

Figure 68, The line of the rill. Generated with the downslope area tool.
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It is possible to compare the way the rill flows with the picture of the rill in the
analytical hillshading layer. To do this, the parts of this layer with the value 0
should be considered as no data. In the left part of the screen, an overview with
information about the current selected layer can be seen. (figure 69)

Properties: 04. Downslope Area

= Legend '@ History EH attributes
Settings € Description
= Options
=l General
Mame Downslope Area
Description

Mo Data
1= Show Legend
Style

Unit
Z-5cale
Z-Offset
Show Cell Values
Maximum Samples
File Cache

= Display
Transparency [%]
Show at all scales

Resampling

vertical

a-=-

0.814771

0O &

0

Mearest Meighbour

X

Apply Restore

Load Save

Figure 69, Menu with data on current selected layer. (Properties menu)

Within the circle in figure 69, the data is typed that should be considered as “no
data”. All the values outside of the line in figure 68 are 0 and should be

. For this reason, type 0 as a no data value in this box as
shown in figure 69. Everything except for the line of the rill will then proceed to
be invisible. Making it ideal to lay it over the analytical hillshade, as shown in the

considered as “no data”

example in figure 70.

Figure 70, The downslope area line in as a new layer above the analytical hillshade layer.
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I1.5.6 Converting the downslope area grid to a shape,

In this paragraph it is explained how to convert the grid layer, downslope area,
to a shape. This requires multiple steps. First the grid layer will be converted to
points, then the points will be converted to lines, the lines will then be used to
make a buffer around the rill.

To start, go to Geoprocessing > shapes-Grid Tools - Vectorisation = Grid
Values to Points. A new menu will appear as shown in figure 71.

L X
Data Objects

= Grids

I=I Grid system 0.012833; 10679« 11493y: 632950.823620x 6668019.34053 1y Cancel
=> Grids 1 object (Downslope Area)
= Shapes
<< Shapes <creates
Save
= Options
Exclude MoData Cells Defaults

Type nodes

Info <<

Figure 71, Creating points from grid values.

Select the downslope area grid from the right grid system in the top two rows of
this menu. Since the values with 0 are marked as “no data”, it is good to leave
the checkbox near “Exclude NoData Cells” checked. When done, click okay.

Points with every value in every gridcell wil now be made. The next step is the
same as done before in I1.3.3. The points will be converted to lines. Click on
Geoprocessing - Shapes - conversion - convert points to lines. Select the
points to convert into lines in the next menu and click on Okay when done. The
points will be connected with lines as shown in the example In figure 72.

Figure 72, Points are now connected with lines.
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The next step is to add a buffer of around 5 cm on this line since the rill in this
case is 10 cm. If the rill is for example 30 cm wide, then add a buffer of 15 cm
and so on.

Click Geoprocessing - Shapes = Tools - Shapes Buffer. The following menu will
appear, as seen in figure 73.

hed
= Data Objects -
=l Shapes
[= »> Shapes 01. line rill Cancel
[= Buffer Distance <not set>
Default 0.05
<< Buffer 01. line rill [Buffer] Load
=l Options
Dissolve Buffers save
MNumber of Buffer Zones 1 Defaults
Arc Vertex Distance [Degree] 5
Info <<

Figure 73, Select the line shape and add set the buffer distance to 0.05 metres.

Click okay when done. The buffer should look like figure 74.

Figure 74, Buffer around the line. Marking the 10 cm wide rill.

Now, just like before, the DEM and resampled DEM are going to be clipped with
the buffer shape. Go to Geoprocessing - Shapes-Grid Tools = Spatial Extend >
Clip Grid with Polygon. The same menu as in figure 47 will appear.

2 clips will be made here. One clip using the buffer as the polygon to clip the:

- Second resampled clipped grid as shown in figure 62. (flattened Z values)
- Original clipped grid. (original Z values with depth of Rill)

The two clipped DEM’s should look like figure 75.
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Figure 75, Clipped DEM and the clipped Resampled DEM should both look like this.

This is the DEM and the Resampled DEM will be subtracted from each other in
the next step.

I1.5.7 Calculation of the volume.
The DEM and Resampled DEM now need to be subtracted from each other. Go to
Geoprocessing » Grid > Calculus - Grid difference. The menu in figure 76 will

appear.
X
= Data Objects Okay
= Grids
-| Grid system 0.012853; 2547x 3264y; 633021.641997x 6668059.942 Cancel
ES. Y 01. clip criginal DEM
»> B 02. Clip resample 2
<< Difference (A - B) <create> w Load
Save
Defaults
Info <<

Figure 76, Select both clipped DEM’s (clipped with the buffers), The original in A, and the
resampled in B.

This will result in a new layer called: Grid-difference (A - B).

This layer is used in the last step.
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The last step is to calculate the volume of the grid difference layer. This can be
done via Geoprocessing 2> Grid - Calculus - Grid Volume.

This menu allows for the calculation of the volume of grids as seen in figure 77

b4
=l Data Objects
= Grids
—I Grid system 0.012853; 2547« 3264y, 633021.641997x 6668059.942210y Cancel
== Grid 03, Difference (A - B)
= Options
Method Count Only Above Base Level Load
Base Level 0

Save

Defaults

Info <<

Figure 77, Grid volume calculation.
Add the difference (A - B) layer to the Grids the volume calculator should use.

The best method up until now is to count only below base level. The base level in
this case will be 0 since this is the highest Z value, to be found in this layer now.

Click okay to start the calculation. The answer of the gully’s volume will be given
as a notification. (figure 78)

=

Grid Volume *

o Volume: 0.031863

Figure 78, Apparently the gully’s volume in this case is 0,031863 m?3. This is a reliable calculation
according to our estimations.)

This is how the volume of rills and gullies is calculated. Be sure to compare the
answer with some estimations to check whether the answer is correct or not.
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I1.6 Using LISEM to simulate ephemeral gully erosion

To simulate the catchment in an area, like Skuterud, one can utilise LISEM to
simulate gully erosion in the area. In this paragraph it is explained how to make
a simulation in LISEM of gully erosion. The area of Skuterud will be taken here as
an Example.

Since rainfall is one of the main factors that cause gully erosion, this will be
considered with the simulation. When LISEM is opened, the first screen will
appear as seen in figure 79.

openLISEM version 5.2 - 2019/03/25 - S >
2R KOO0 P

Input/Output  Map dbase  Simulation

PUT OUTPUT
Database Graphs and tabels
Run file(s) | nessed_up/Runfie/skuterud_gullyerosionl.run 3 = = Catchment and outlet totals ‘resu?ts.m
Map directory Winputdata/Skuterud_Generic_messed_up/Maps/| [ Outlet/Sample point Hydrographs |hydrograph.csv | O3 separate point fies
Result directory Fkutemd_GEnar\c_messad_upresu?ts/tes‘tfﬂoiﬂﬂV‘ = Background satelite image El | (E)ms'"" units
ton/ha
Rainfall fle penLISEM/inputdata/Gryteland/rain/Ar2syears.txt | (8] ] O Hydrographs in PCRaster format Digtts in output and display ® kg/m2
Snowmett file 2 =0 @® Hydrographs in comma-delimited format O ka/cel
Simulation times Maps and map series
Timestep (sec) Begin time (min) IIl End time (min) Spatial Totals ~ Time series
Simulation options [ write maps as GTiff (NOTE: without cartographic projection information)
~ Hydrology maps Flood and channel maps
Global ~ Interception  Infitration ~Flow  Erosion  Sediment Transpori
Rainfall (mm) rainfal. map Cumulative channel discharge (m3)|chandism3.map
Surface flow Interception (mm)|interception.map Max channel water level h h
[ 1D Kinematic wave (using LDD flow network) Infitration (mm)|infitration.ma ax channel water level (m) | chanmaxwh. map
. - .map
[ 2D Diffusive wave (Using DEM) Overtand fow )ﬁi Max discharge (m3/s) chanmaxq.map
2D Dynamic wave (using DEM) veran mm)|runoff.map
Flood duration (min)|floodtime. maj
Flood threshold: flow height reported as floed (m) Max Water level (m)whmax.map (min) P
Sediment Max velocity (my/s)[vmax.map Flood start (min)|floodstart.map
Include erosion processes Max momentum VH (m2/s) VHmax.map Flooded building stats|floodstats.csv

. Advanced sediment processes

Sediment ma
Channels and rivers ps

Include channel/river Detachment eros.map
« [ channel infitration

« [ channel basefiow

Deposition|depo.map

Soiloss Map | soiloss.map

Infrastructure landunits erosion stats |totlandunit.txt
[ Indlude buidings —— [ 1nclude road system —— [ include hard surfac =
o [ Include rainwater storage by drums Channel detachment|chandet.map

Channel deposition|chandep.map

Parallel processing
—= -

Figure 79, The first menu in LISEM.
Here, one can set the first settings for the simulation. These settings include:

- Which Run-file to use
- Which map package to use, (it needs a map-directory for that)
- Which rainfall file to use, (and if necessary, a snowmelt file)

The first step should be to obtain these files from the specific area that must be
simulated. These files can be obtained within NIBIO.

Paragraph I1.6.1 will explain how to run a basic simulation. Paragraph I1.6.2 will
explain how to modify map-files and txt-files to run a more realistic simulation of
gully erosion.
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I1.6.1 Running a basic simulation in LISEM
To run a basic simulation, LISEM needs a couple of files which contain the
characteristics of the catchment in the area. These files are basically
administrated in the following categories, as seen in figure 80.

Select run file(s) *
« v <« openLISEM » inputdata » Skuterud_Generic w | Zoeken in Skuterud_Generic ye
Organiseren = MNieuwe map == ~ [ 6
~ MNaam - Gewijzigd op Type Grootte
# Snelletoegang
Maps 7-5-201913:27 Bestandsmap
@ OneDrive Rain 25-4-2019 15:46 Bestandsmap
I Deze pe Results 30-4-2019 14:00 Bestandsmap
. Runfile 8-3-2019 14:15 Bestandsmap
§ 30-objecten G h Am e e
SwatreTables 29-4-2019 15:46 Bestandsmap
&= Afbeeldingen
[ Desktop "
Bestandsnaam:“ v| *run v
Annuleren
Figure 80, Recommended map structure for files to use in LISEM.
It is recommended that all the files of an area will be saved in this order to
prevent confusion in LISEM. The first file to add in LISEM is the RUN-file. The
RUN-file forms the backbone of the whole simulation made in LISEM since it
contains a script that discribes which map files and parameters should be used a
certain time. To add a RUN-file to LISEM, simply click map icon, as shown in
figure 81.
. -
cEZHBR K000
Input/Output  Map dbase  Simulation
INPUT
Database
Run file(s) | | @B E &
Map directo —
P Y Select run file(s) X
Result directory
= v <« inputdata » Skuterud_Generic » Runfile v | D Zoeken in Runfile ye
Rainfall file
Organiseren = Mieuwe map == - [ 0
5 ~
Snowmelt fil I Deze pe &3 MNaam Gewijzigd op Type Gro
————
) 3D-objecten mjskuterud_tesﬂ 0-4-2019 12: RUM-bestand
=] Afbeeldingen jskuterud-AugustZDDS 17-4-2012 RUN-bestand
jskuterud-AugustZO]O 0-4-2019 12: RUN-bestand

[ Desktop

|| Documenten

v £

Bestandsnaam: | skuterud-August2010

~

Annuleren

Figure 81, Click the map icon or type a file directory here to add a RUN-file.
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After the run file has been addes, the file directory should appear in the empty
white row.

Now the maps can be added. This can be done by clicking the map icon or typing
the directory as shown in figure 82.

2B WKl 00O
Input/Output ~ Map dbase  Simulation
NPUT
Database
Run file(s) | rud_Generic/Runfie/skuterud-August2010.run ~ | |2 | 2 @&
Map directory =
Result directory| | =]
Rainfall file | | 2] [E
Snowmelt file 2 = O

Figure 82, Click the map icon, or type a directory in the empty space next to it.

The map-files contain data on each characteristic of the area. Table 6 displays all
of the files that should be in the map directory. The (map) files are the files one
can adjust when certain characteristics of the area are not up to date. This can
be done in a program called Nutshell. (more about this in paragraph I1.6.2) For
instance the ch.map contains data on the crop height of the area. During the
winter, there are no crops and limited vegetation, so it is important to check if
the value in ch.map is the right one.

Table 6, Overview of map files and other files necessary in directory (in case of Skuterud)

Files

Aggrstab.map Hardsurf.map n.map
Area.map Headout.map Outlet.map
Barriers.map Id.map Outpoint.map
Ch.map Inithead.001 Per.map
Ch.map.aux.xml Inithead.002 Profile.inp
Chancoh.map Inithead.003 Profile.map
Chandepth.map Inithead.004 Roadwidth.map
Changrad.map Inithead.005 rr.map

Inithead.006
Inithead.007
Inithead.008
Inithead.009

Chanman.map
Channeltest.map
Chanside.map
Chanwidth.map

Stonefrc.map

Coh.map Inithead.010
Cohadd.map Lai.map
Crustfrc.map Idd.map
D50.map Iddchan.map
D90.map Iddchanscalar.map
Dem.map Iddchantest.map
Grad.map MDS.map
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These map files are used to simulate a catchment. This may seem a bit
overwhelming, but the only a few files need to be modified in case of a more
realistic simulation of the catchment (gully erosion) in Skuterud. However, all
these files are necessary in LISEM to be able to run a simulation.

The next step is to set a result directory, as shown in figure 83.

R @kl QDO

Input/Output  Map dbase  Simulation

INPUT
Database

Run Fle(5j|-rud _Generic/Runfile/skuterud-August2010.run V| 2| =

Map directory efopenLISEM/inputdata/Skuterud_Generic/Runfile | |[=

Result dlrectory|| h:.-l
Rainfal ﬁle| | 2| |E

Snowmelt file = 1=

Figure 83, Type a directory to store the simulation’s results or select one by clicking the map icon.

It is important to create a new result directory with each simulation! Otherwise
the previous results will be overwritten. New maps can be created just by typing
them in the result directory.

Now, a rainfall file should be added. More rain means more run off, and more run
off means more ephemeral gully erosion on agricultural fields. The selection of
the rainfall file is shown in figure 84.

|:: FEEEET O

Input/Output  Map dbase  Simulation

INPUT

Database

Run file(s) ‘:rud_GenerichunﬁIefskuterud—AugustED1[].run v‘ 3| =] |2

Map directory ‘efopenl_ISEM,Fin putdata/Skuterud_Generic/Runfie ‘ (=

Result directory 2/openLISEM/inputdata/Skuterud_Generic/Results| =

Snowmelt file Select a rainfall I

Figure 84, Select a rainfall file by clicking the map icon or by typing its directory.

Rainfall files are txt-files that contains data on the amount of rainfall at every
timestep. Once the rainfall file’s directory has been added to LISEM, one can click
on the txt file icon (blue square in figure 84), to show how the rain will fall during
the simulation. A text-table will appear with 2 columns as shown in figure 85.
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Ar2Syears.b — O x
RUU CSF TIMESERIE INTENSITY NORMAL 1 ~
station_1

0 0.000

220 0.000

230 0.046

260 0.000

270 0.046

390 0.000

400 0.046

570 0.000

580 0.046

1150 0.000

1160 0.046

1170 22.573

1220 0.000

1230 193.750

1260 0.000

1270 1.108

1280 2.308

1290 1.985

1300 4,108

1310 1.062

1360 0.000

1370 10.063

1380 19.5618

1390 5.401

1400 47.407

1420 0.000 v

Figure 85, In the rainfall file, the left column shows the timestep and the right column shows the
amount of deposition at the given timestep.

All time steps are given in seconds. Looking at this table will also come in handy
when the simulation is already running to know when the rainfall in the
simulation will start.

Setting the duration of the Simulation is also important. This can be set in the
input/output tab under simulation times as shown in figure 86. Be sure to select
the begin time and and time in correspondence with the rain file.

Simulation times
Timestep (sec) | 60| Begin time (min) | 275| End time (min) | 1250 |

Figure 86, Setting simulation times.

Once the time steps are taken care off, a couple of more factors can be checked.
When calculating gully erosion, it is important to cross out the boxes for
Sediment (Include erosion processes, Advanced sediment processes.) as shown
in figure 87.
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Global =~ Interception Infitration = Fow  Erosion  Sediment Transport  Calibration

surface flow @)
[ 1D Kinematic wave (using LDD flow network)
[ 2D Diffusive wave (Using DEM)
2D Dynamic wave (using DEM)
Flood threshold: flow height reported as flood (m)
Sediment
Include erosion processes
» Advanced sediment processes
Channels and rivers
Include channel/river
« [ Channel infittration

« [ Channel baseflow

Infrastructure
U Include buidings ----- Include road system ----- U Include hard surfaces
» Include rainwater storage by drums

Paralel processing
Nr of CPU cores used, more cores is faster but prone to errors (0 = all cores; 1 = 1 core efc.)

Figure 87, Global tab in the Input/output tab in LISEM.

It is also possible to include hard surfaces, road systems or buildings, provided

the map-files are available in the map-file directory.

When it comes to simulating gully erosion, “infiltration” is one of the most

important parameters that determines the development of gullies. When it comes

to setting the infiltration parameters, SWATRE-tables are usually used. SWATRE-
Tables are txt-files that contain information on the permeability of each type of
soil. Which soil layers are in a specific point is mentioned in the profile.map file.

SWATRE-tables are imported to LISEM, as shown in figure 88.
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Global  Interception  Infitration  Fow  Erosion  Sediment Transport  Calibration
Infittration model ®
SWATRE 4

General options

2 layer Green _Ampt or Smith _Parlange (needs 2nd layer maps)
o [ Impermeable lower soi boundary
. Percolation from lower soil boundary (moisture content wil change)

[ Include compacted areas (needs additional maps)
[ incude crusts (needs additional maps)
[ indude grasstrips (needs grass width and grass ksat maps)

* Mannings n grass strip: |U.3 |

Swatre options
[ Include tile drain system (EXPERIMENTAL, only with SWATRE infi)
geometric average Ksat

Profile table fie |utdataf5kuterud_Generiq’ Maps/profile.inp | =1l

Swatre table dir hputdatafskuterud_GenericfSwatreTabIesf | =

Figure 88, Set "SWATRE” as the method to quantify the amount of infiltration in the area.

After SWATRE is selected as the infiltration model, set the directory for LISEM so
it can find the SWATRE-tables. This option can be found under “Swatre options”.

On a side note, in some cases the infiltration is too high when looking at the
simulations. This would call for some modifying of the permeability numbers in
the SWATRE-tables. This can be easily done by opening the SWATRE-tables in
Excel and lowering the permeability values (k). (this can be helpful when the soil
is frozen, for instance.)

The simulation can now be run by clicking the play button in the toolbar on the
top of the screen, if all necessary maps are imported to LISEM. (figure 89)

openLISEM version 5.2 - 2019/03/23
FHR K 00O

Figure 89, Toolbar on top of the screen in LISEM.

If not, all maps are there, LISEM will give an error notification, telling which file
is missing. These files can be (re)created using Nutshell, or simply copying and
pasting another map with the same values. For example, when an error appears
that d90.map is missing, it is possible to convert the d50.map in nutshell to a
d90.map and then save it as d90.map. This prevents errors and will not interfere
with the simulation (if the values of the maps are supposed to be the same).

While running the simulation, it is possible to check in on the progress made via
the simulation tab, as shown in figure 90.
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28% (387-1380)

4

Input/Output  Map dbase  Simulation
size
time (min) End time (min) Total Discharge (I/s)
Celeze (m) Area (km2) 2,500 [ et
Water
Surface Channels
Predipitation (mm) Channels (mm) i
Interception (mm) Baseflow (mm) o
Infitration (mm) Fiood (mm),h>50) - "
Surface Store (mm) Discharge (mm) 0.000 iF; -
Runoff (mm),h<50) QP (%) 0.000 2,000 i
Sediment . Liese
Surface Channels
Splash (ton) Detachment (ton)
Flow detachment (ton) Deposition (ton)
Deposition (ton) Sediment in flow (ton) o
Sediment in flow (ton) 1500 F
Total
Soi loss (ton) Sed. Del. Ratio (%) ~
o loss (kg/ha) T i
Catchment outlet 1 £ Ly
Total discharge (m3) Qpeak (/s)
Qe peak time P (min)
Sol loss (ton) peak time Q (min) 1,000
Map Display
Buidings
1 O Roads
1 O Channels - [ 1e+50
Image 500
1 Relief, contours:
[ ]
Total Discharge (/s) ~+ [0.00 2] [0.00 1
[ | Total Soil Loss (kg/m2) +|[0.00 < Jo.o0 1l
Info f
Hydrograph Point (0, 1-1)[1 2]  logscaing rainfalllo 2]
runtime (min) m-z end run (miny [ 6.798] T T T T T T T T
1 o S 6) 0.0008+00 -500 0 500 1,000 1,500 2,000 2,500 3,000
[Average dynamic timestep (dl 0.000 sec, n n) ] m

Figure 90, Simulation tab.

The simulation screen provides information about the catchment in Skuterud.
The buttons in the red square are useful for toggling between a map view of the
area (in this case Skuterud), Or a hydrograph of the area as shown in figure 91

Hydrograph 1

Q(I/s) - P (mm/h)

|
Y
I 1
f il it L
‘FI |
/ 0l
m.

T T
400 600 800 1,000 1,200

time (min)

-6
F3
?
Fa 2
=
Qa
-
)
—
'
(]
F3 &
~
=
F2

| m Rainfal ® Discharge ® Sediment discharge ® Concentration

Figure 91, A hydrograph of Skuterud after some rainfall.
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The hydrograph provides information on how much rainfall, discharge, sediment
discharge and concentration there is spanning over the duration of the
simulation.

The map provides information on how rainwater runs off in the area. The map
can also show different data which is available by clicking the tabs in the purple
square. (figure 90) The tabs contain the following information: (figure 92)

Water Height (m)
Flow Velocity (m/s) a
Flow Momentum (m2/s)
Channel Discharge (I/s)

Channel Water Height (m) Sediment Load (kg/m2) -
Channel Velocity (m/s) Total Soi Loss (kg/m2
Interception (mm) 1 P
Infitration (mm) :
Rainfall Cumulative (mm)
Rainfal Intensity (mm/h)
Flood Height, h=50 mm (m)
Max Flood height (m)

Flood Start Time (min)
Flood duration (min)
Timestep (s)

CoreMask (-)

o

d

=]

suspended sed (kg/m2)
bedload sed (kg/mz2)
TC suspended (kg/m2)
TC bedload (kg/m2)
Sed Concentration (kg/m3)
Splash detachment (kg/m2)
Flow detachment (kg/m2)

Transp-crrt Capacity (kg/m3)

—

Total Discharge (I/s) =

Figure 92 All of the information that can be shown in the map.

Keep in mind to always create a new result directory if there is need for another
simulation with differen parameters. This way the old results will not be
overwritten. This is it when it comes to running a basic simulation of the
catchment in an area.

I1.6.2. Modifying map files

To get a more realistic representation of the catchment in an area, it is necessary
to modify the parameters in some maps. The files that should be changed
according to the current situation are shown in table 7. The changes of the
situation of the map parameters are related to the time of year.

Table 7, Overview of files that must be modified.

file specification Why it needs to be changed Range
of
values
Ch.map Crop height map The parameters in these maps need 0-30
Lai.map Leaf area index map to be changed to match the winter  0-12
Per.map percentage of vegetation  situation of the area. So low crop 0-1
covering the soil height, a low leaf area index and a

small percentage of vegetation
covering the soil.

SWATRE The SWATRE-tables The permeability of the soils should -
tables contain permeability be lowered since the soil is frozen
parameters (k) of each in the winter period (when most
soil type. gully erosion occurs)
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To change the first attributes in ch.map, lai.map and per.map, one must use
Nutshell. Nutshell makes it possible to change the values within the map-files.
Once nutshell is opened, the first screen looks like figure 93.

R Nutshell (vers
File Run Edt Find Format Help

DEEEBR+ LD NS ARIR c=sEEFE0R0

10 {_Generic_messed_up/Maps =
= 000=
READVE bt Y]
1LISEM eror d on 17.04.2012 - 12:50:27
2 Eoverflowi :Calc error in D:\prgc\lisemroot\lisemmc\lisPrassbalsed
3
Command st pcrealc ~matrixtable ch.map = lookupscalar(ianduse.map. 3, vea.tbl) Mi=Nal

Date Modified
3620191540
12:2-2019 19:44
24-4201915:12
1462019 19:44
84-20191022
66-201915:59
66-201911:04
7-6-2019 1224
7-5-20191326
csed_up 7-6-2019 10:44
10-5-201912:38
9-5-2019 1458
7-6-2019 1117
14-5-2019 1435
9-5-20191520
10-5-2019 16:11
7-6-2019 1115
30-4-2019 09:47
4-6-2019 1451
9-4-2019 1500
2052019 11:27
7-5-20191231
15:4-2019 10:52

5 #DGQIED‘I BHE@
o Size. Date Modified  Type
264K 14420111308 mapFile
264K8 301120101030 map File
264K8 20420191248 map i
264K8 6520191257 mapFile
264KB 15-12:201 1825 map e
264K8 0420191257 mapFie
264K8 21220101232 mapFie
2648 14-12:2010 1111 map e
264K8 21220101155 mapFie
264K8 21220101158 mapFie
2648 212:20101229 map e
264K8 0420191307 mapFile
264K 20:112007 1327 map File
264K 29:1.2007 1327 map il
264K8 20:11-2007 1327 map il
2648 0420191255 map e
264K 15:122011 1226 map il
264K 20:11-2007 1326 map File
264 KB 4-11-20101335 _map e

10-4-2019 1439
3.6-20191507
8-4-20191026

n 5.3 [6 0ct 2018)) - x

Figure 93, Base menu in Nutshell.

To modify the maps, the directory where the maps are saved should be selected
first. This can be done within the red square in figure 94. By clicking the maps
directory, the map-files should appear in the menu within the green square.

Now to start modifying a map’s values. Click on a map that needs other values in

the map list (green square) to select it. Double click, to open the map (the
programme Aquila is needed to view these maps, so be sure to install it)

B Aguila - C:/Users/mauri/Documents/HAS/HAS jaar 3/Buitenl...  — [m] X
File Edit View Help

C:/Users/mauri/C
T

Figure 94, Ch.map of Skuterud. The values depict crop height in meters. (red is a forest)

Since most gully erosion appears during the winter period (when there is almost
no vegetation), it is necessary to change the crop height in the agricultural fields
to around 10 centimetres, max.
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To change the values in the map, select ch.map in nutshell and click on the map
edit icon, as shown in figure 95.

#ll!ll@ll.m

5 Name Size  Date Modified
[E.p aggrstab.map 264 KB 14-4-201113:08 map File
i area.map 264 KB 30-11-201010:30 map File
Ql barriers.map 264 KB 30-4-201912:48 map File
E? 264 KB 30-4-201913:07 map File
- chancoh.map 264 KB 13-12-2011 18:26 map File
= chandepth.map 264 KB 30-4-201912:57 map File
= changrad.map 264 KB 2-12-201012:32 map File
@ chanman.map 264 KB 14-12-201011:11 map File
@ channeltest.map 264 KB 2-12-201011:55 map File
_ chanside.map 264 KB 2-12-201011:58 map File
I.’ﬂ chanwidt.map 264 KB 2-12-201012:29 map File

Figure 95, Select a map = map edit.

A new screen will appear in which it is possible to modify the map values. (figure
96)

[EB MAPEDIT 1.12 (02/01/2015)

EEE RANEEY vl (@@ B0 @@
[UsersimauriiDocuments/t

02

105

19

275

36

445

53

6.15

T

X Y[ 6082.5,186025.9] col,row[114,152] value => 0.7

Figure 96, It is also possible to determine the value by looking at the colour in the
legend.

While
moving the cursor over the map, it is possible to see the current value of that
certain part of the map. This value is shown at the bottom of the screen in figure

97.
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In this case, the crop height at the place of the cursor is 0,7 meters high. This
area is an agricultural field in Skuterud. During the winter, there are only some
remains of the crops. For this reason, the crop height needs to be changed to 0,1
meters. To do this, click the “edit cells between two values” icon, as shown in
figure 97. A small menu will appear that asks which values to select.

ﬁ MAPEDIT 1,12 (02/01/2015)

2o %angRIET  voraw (@9 @0Hr @0

fUzers/mauriDocuments/k edit cells between two values|

Select with values

Edit all values between and including:

07 Minimum
07 Masimurn

o [ 36 caeel]

Figure 97, Editing cells between two values.

The values are put in the small menu as shown in figure 97. All cells with that
value are now selected in the map and have changed colour. Now the selected
cells can be modified, as shown in figure 98.

m MAPEDIT 1.12 (02/01/2015) - O

2HBE %N EEl__Jdprcaw @e@ H0HC 00

{UsersimauriDocuments/k Execute replacement selection with edit value|
02
1.05
19
275
3.6
445
53
6.15
¥

Y[ 5788.2,187547.4] col,row[ 85, 0] => missing

Figure 98, Type the new value of the selected cells in the area within the red square

After the new value is filled in, click on the “check” icon to finish the editing. It is
now possible to either save the map under the same name, overwriting the last

version or save it under a different name. Just click the save icon on the top left
part of the screen to finish up.

Now the value is modified. Repeat these steps if the modification of other values
in other maps is deemed necessary. All the maps have the same PCraster lay-
out, so it all works the same way.
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Attachment III: Research design, field measurements vs

drone measurements
This attachment describes the way the conventional measurements and drone
measurements were taken in the field.

5 conventional measurements were taken in the field but due to some
complications with the conventional measurements, only conventional
measurement 2, 4 and 5 were able to be compared to the drone images.

Every conventional measurement is marked with two paper markers in the field.
these markers help to elaborate the coordinates of the profile. As seen in figure

Figure 99, The red line between the markers will form a cross section of the profile

The same gully was measured on an altitude of 20 metres with the drone. The
profiles are numbered to retain a good overview. The numbering of the profiles is
given in a schematic in figure 100.

o

Figure 100,, Schematic representation of a rill in with drone measurements 1 till 6 in Skuterud
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Six measurements with the drones were made. Only drone measurement 6, 5
and 2 were compared to conventional measurements in the end to check the
drone’s accuracy. Drone measurement 6 was compared with conventional
measurement 5. Drone measurement 5 was compared with conventional
measurement 4 and Drone measurement 2 was compared with conventional
measurement 2.

As the rill continues to the east, the rill becomes more and more flat according to
the field measurements. The digital cross sections where made of these profiles
using the drone imagery. The cross sections of the conventional measurements
have been detrended, as well as the cross sections of the profiles that are made
in SAGA. A detailed explanation of this process is given in paragraph II.4.

Due to irregularities with the drone measurements, not all profiles compared
because it was hard to make out which drone profile matched each conventional
measured profile. Another thing that caused confusion is that 5 conventional
measurements were done in the field, while 6 sites where marked with markers.
For this reason, only the drone profiles that matched the conventional
measurements are shown. (Of which there are 3 of in chapter 5)
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